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USPS Customer Commitment 

The U.S. Postal Service™ fully understands the importance of providing information and service anytime day or night to your Internet and eCommerce 

customers. For that reason, USPS® is committed to providing service 7 days a week, 24 hours a day, 365 days a year. Thank you for your continued patronage. 

 

We invite you to share your comments on how we can improve this application for you and enhance functions offered in future releases of Shipping Assistant.  

Please email the USPS at shippingassistant@usps.gov. 

 

Trademarks 

Delivery Confirmation™, Signature Confirmation™, Express Mail®, First-Class Mail®, Parcel Post®, and Priority Mail® are registered trademarks of the U.S. 

Postal Service. 

 

Priority Mail International®, Express Mail International®, and First Class Mail International®, USPS Web Tools®, and ZIP Code™, ZIP + 4®, and ZIP® are also 

registered trademarks of the U.S. Postal Service. 

 

Internet Explorer®, Microsoft®, Microsoft Excel®, 2003®, 2000®, XP Home®, XP Professional®, Vista®, Windows® and .NET® are registered trademarks of 

Microsoft Corporation. 

 

To Our Customers 

If you require technical support, contact the USPS Internet Customer Care Center (ICCC). This center is available from 7:00AM to 11:00PM EST daily. 

Email: icustomercare@USPS.com     

Telephone: 1-800-344-7779 (7:00AM to 11:00PM EST) 
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Chapter 1. Introduction 

Shipping Assistant is a free and convenient software application that provides easy access to shipping services from the United States Postal 

Service. Major functionality includes the ability to create domestic and international labels, customs 2976/CN22, customs 2976A/CP72 labels and 

forms; the ability to answer your customers’ questions about shipping fees or tracking information; the ability for your company’s customer 

service representatives in a call center, customer service, or shipping department to easily access shipping-related data and create Electronic 

Merchandise Return labels that may be provided along with your package or e-mailed to your customer. In more detail, Shipping Assistant 

provides the following USPS shipping services and information: 

 

Create Shipping Labels 

• Domestic Shipping Label generates a single-ply barcode label for Express Mail (parcel and flat rate envelope) and Delivery or Signature 

Confirmation bar-coded labels for Priority Mail (includes parcel, flat rate envelope, flat rate box, large flat rate box, and small flat rate box), First-

Class Mail Parcels, and Package Services (Parcel Post, Media Mail, and Library Mail). If integrated with a postage meter, users can include 

insurance, print postage, and capture weight. 

• International Shipping Label generates a multiple-ply bar-coded label for Express Mail International (includes parcel and flat rate envelope), 

Priority Mail International (includes parcel, flat rate envelope, flat rate box, large flat rate box, and small flat rate box), and First Class Mail 

International (includes parcel, flats, and letters). If integrated with a postage meter, users can include insurance, print postage, and capture weight.   

• Customs 2976/CN22 Form and Customs 2976A/CP72 Form generate a form to accompany international shipments or domestic APO/FPO to 

declare the contents and value of your shipment – helping to expedite delivery of your packages and swiftly clear customs.  

• Electronic Merchandise Return Label generates a postage-paid return label with your Permit account number for Priority Mail, First-Class Mail 

Parcels, or Package Services mail classes. 

• Open and Distribute Label provides the ability to create Priority Mail Open and Distribute labels, as well as automatically creating a PS 3152 

Form. Users can pay for postage via Permit or an integrated meter device. 
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Shipping Cart 

• Shipping Cart provides the ability to store created labels for processing and printing at a later time. In addition, the Shipping Cart allows 

you to preview labels that are READY for printing and allows you to view/fix errors for labels in an ERROR state. If integrated with a 

postage meter, users can print postage from the Shipping Cart. 

 

Review My Shipments 

• Review My Shipments provides the ability to view previously printed label data, track status, schedule Carrier Pickup requests, and 

leverage information to recreate labels and create electronic Merchandise Return labels. If integrated with a postage meter, users can 

print postage from Review My Shipments.  

• Carrier Pickup™ section provides the ability to schedule free USPS Carrier Pickup requests for printed domestic and international labels 

based on the Next Postal Delivery Date available. 

 

Use Shipping Tools 

• Track Packages checks the bar coded delivery status of any package shipped, whether created with Shipping Assistant, USPS retail 

location, or other channel. 

•  Address Lookup is a standalone address-checking tool. The address-checking tool provides address standardization, and city/state and ZIP 

Code lookup features.  Shipping Assistant uses the USPS Address Management System database to standardize addresses by correcting errors 

in street addresses and returns the ZIP + 4.  City/state lookup provides the city and state corresponding to any given ZIP Code.   

• Domestic Rate Calculator/Service standards calculate and compare single piece postage rates, delivery standards, discounted 

electronic rate Confirmation services fees, and insurance fees for packages shipped domestically by First-Class Mail Parcel, Express 

Mail (includes parcel and flat rate envelope), Priority Mail (includes parcel, flat rate envelope, flat rate box, large flat rate box, and small 

flat rate box), and Package Services mail classes. If integrated with a postage meter, users can print postage and include insurance 

within Shipping Tools, 

• International Rate Calculator/Service standards calculate and compare single piece rates, delivery times, maximum weight limitations, 

and maximum dimensions for a specific destination country for Express Mail International, Priority Mail International, and First Class Mail 
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International.  Also provides country specific mailing conditions and restrictions. If integrated with a postage meter, users can print 

postage and include insurance within Shipping Tools, 

 

Address Book 

• Address Book provides the ability to add, edit, delete individual addresses, import and export bulk addresses, manage address groups, 

and apply addresses to create labels faster and easier. 

 

Preferences 

• Preferences provide the ability to assign default information into your shipping labels and other areas of Shipping Assistant . A unique 

set of preferences can exist for each selected sender address, allowing you to create multiple profiles of preferences within a single 

version of Shipping Assistant. Preferences also provide the ability to manage an external device such as a postage meter. 

 

Message Center 

• Message Center provides the ability to view USPS Shipping Assistant or mail service related message updates via a browser within 

Shipping Assistant. Also, access USPS Postal Store for ordering free mailing supplies or self-adhesive labels.

 

Offline Capabilities 

• Offline capabilities throughout the application provide a way to make use of limited-functionality of Shipping Assistant without Internet 

connectivity. Offline functionality available includes, but is not limited to, adding domestic, international, and/or customs labels/forms to 

the Shipping Cart.  

 

Print Postage and Capture Weight with external device 

• Integration with an external device provides the ability to capture the weight of an item and print postage directly from Shipping Assistant 

to the postage device.  

 

For further quick-reference information, refer to the Help link in the Shipping Assistant application. 
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Chapter 2. Getting Started 

System Requirements 

Shipping Assistant is supported on Windows XP Home, XP Professional, 2000, 2003, and Vista Operating Systems. In addition, you will be 

required to have: 

• Internet Explorer version 6.0.1 (or higher). 

• At least 7 MB of free space to install and run the program (If .NET 2.0 framework is already installed. .NET 2.0 framework requires at 

least 80 MB of free space) 

• Screen Resolution is set at a minimum of 1024 x 768 pixels 

• At least one printer installed in order to use the Print Preview functionality in Shipping Cart. 

• Adobe Reader is required to view Electronic Merchandise Return (EMR) labels via the attachment when an email recipient is requested 

by the Sender. 

• A PC with an Internet connection is required to register for Shipping Assistant and use the key online capabilities and attain application 

updates from USPS.  

• If you wish to print postage and capture weight through a postage device, ensure that all associated programs (Example: mailstation™) 

are running and minimized to the taskbar prior to launching Shipping Assistant   

 

Data Entry Guidelines 

Before using Shipping Assistant, you should have a working knowledge of the following guidelines for data entry that apply to all screens in the application: 

• Any fields with a RED asterisk adjacent to field label name are required fields. 

• Fields that are already populated. 

• Shipping Assistant will not alert you to invalid data until a request is submitted.  An error message dialog box will be returned when an error is 

encountered. 

• Fields with drop down boxes contain all valid entries for that field.  You cannot enter any other data. 
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• ZIP Code fields only accept five numeric characters. 

• ZIP + 4 fields only accept four numeric characters. 

• Pounds and ounces fields only allow numeric characters.  If the total weight is invalid an error message will be displayed. 

• Invalid combinations of city/state or city/state/ZIP Code will cause an error message to be displayed.  This error message will have to do with an 

invalid address rather than invalid characters. 

• The status bar has a status indicator that describes the process of the requested task.   

• If an error message is returned a pop-up box will appear with the error description.  If the error was due to the input on the screen, corrections can 

be made and the request re-submitted. 

• Clicking on Exit on the upper right hand side of the application will exit the Shipping Assistant application. Clicking on the X button on the top right 

hand corner of the application will minimize the application and keep the application running in the Windows system tray. Note: In Preferences > 

Advanced tab, there is the ability to change the setting of the X button to exit the Shipping Assistant application entirely instead of minimizing the 

application to the task bar. 

• Communication between your instance of Shipping Assistant and USPS servers occurs via a Secure Sockets Layer (SSL) connection to maintain 

integrity of the data. 
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Chapter 3. Shortcuts 

When selecting records within Tables 

In Shipping Cart, My Shipments, Carrier Pickup and Shipping Tools - Track/Confirm tables, the following shortcuts apply when selecting (i.e. 

highlighting) and/or checking records.  The Address Book does not have checkboxes, so when dealing with addresses simply highlight 

the address(es) wanted. 

 

IMPORTANT: In general, always first select (i.e. highlight) the rows you wish to apply an action to (i.e. edit, delete) and then make use of the 

checkboxes. 

 

Q. How do I select (i.e. highlight) a record?  

A. Click on any of the read-only text field columns in the grid.  

 

To check multiple label records in a row: 

1 Select (i.e. highlight) a label row by clicking on any of the text fields. When a record is selected, the entire row will be highlighted. 

2  Hold down Shift key. 

3  Select another label row by clicking on any of the text fields. All records between the first and last selected rows will be selected. 

 

TIP 

- To deselect one of the rows while multiple rows are selected, press the Ctrl key and click on any of the text fields on the row that you wish to deselect. 

 

4 Click on a single checkbox of one of the selected (i.e. highlighted) rows. All highlighted rows will be checked. 

 

TIP 

- To uncheck all records that are selected simply click one of the checkboxes again. All records that are selected will be unchecked. 
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To check multiple label records not in a row: 

 

1 Select a label row by clicking on any of the text fields. When a record is selected, the entire row will be highlighted. 

2  Hold down Ctrl key. 

3  Select another label row by clicking on any of the text fields. Only the rows clicked on will be selected. 

 

TIP 

- To deselect one of the rows while multiple rows are selected, press the Ctrl key and click on any of the text fields on the row that you wish to deselect. 

 

4  Click on a single checkbox of one of the selected (i.e. highlighted) rows. All highlighted rows will be checked. 

 

TIP 

- To uncheck all records that are selected simply click one of the checkboxes again. All records that are selected will be unchecked. 

 

Keyboard Shortcuts 

To check a checkbox for a record in the My Shipments, Address Book, Carrier Pickup, Shipping Cart, or Shipping Tools - 

Track/Confirm tables: 

1 Tab into the checkbox column for a specific record. 

2 Press the spacebar key. A checkbox for the selected record will be checked. 

 

To open the edit panel for an address in the Address book: 

a. Tab into the edit arrow column for a specific record. 

b. Press the Enter key. The record will be open for editing. 
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To display the context menu in Shipping Cart, My Shipments, Carrier Pickup tables: 

1 Tab into any of the text columns of a specific record. Note: My Shipments and Carrier Pickup tables will require you to check the row 

selected in order to access all of the functionality available in the context menus. 

2 Click the Context Menu key and use the up and down arrows to navigate to select an action. 

3 Click Enter. 

 

To display a specific main window using shortcut keys: 

• CTRL-L: Create Shipping Label 

• CTRL-R: Review My Shipments 

• CTRL-T: Shipping Tools 

• CTRL-B: Address Book 

• CTRL-S: Shipping Cart 

• CTRL-M: Message Center 

 

To display a specific main window using shortcut keys: 

1 To have JAWS users read status in the middle of processing a request, click Insert > Page Down.
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Chapter 4. Installation 

In this introduction to installation, you will learn how to do the following: 

ONLINE connection status: 

• Download Shipping Assistant via the Internet 

• Upgrade Shipping Assistant 

• Uninstall Shipping Assistant 

 

OFFLINE connection status: 

• Uninstall Shipping Assistant 

 

Getting Started 

 Prior to installing the Shipping Assistant application, verify that all System Requirements have been met.  
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Download Shipping Assistant via Internet 

1 The Shipping Assistant software can be downloaded from the Shipping Assistant web site 

(http://www.usps.com/shippingassistant/instructions.htm).  

2 Click Go link on the website under the Get USPS Shipping Assistant box. 

  

3 Click Install or Run from the popup box. 

 

TIP 

-  If your computer does not have.NET 2.0 Framework already installed, it will automatically be installed onto your computer along with Shipping Assistant.  
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Note: If you are using Internet Explorer 6.1 or later versions, you will see the following dialog. Click Run or Save to your desktop and run 

from the Start menu. 

 

 

4 Click Install from the popup box. 

 

 

Note: If you are using Netscape 6.X or Firefox browsers, you will see the following dialog. Click OK or Save to your desktop and run from the 

Start menu. You will then see the Shipping Assistant Installation dialog which is digitally signed. 
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5 If you do not have .NET 2.0 framework already installed, please note that the additional dialog boxes will display. Click Run: 
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5a View Install Shield Wizard indicating that .NET Framework can be installed 

 

5b In the middle of processing, click Run on the following dialog box.  

 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 4. INSTALLATION        

                    
 

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      25  

5c View Install Shield Wizard after .NET framework has been installed 

 

6 View the Shipping Assistant Installation Wizard Welcome Page. Click Next. 
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7 View Terms and Conditions. You will be required to agree to terms and conditions in order to continue with the Shipping Assistant 

installation process. Click Next. 
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8 Enter Customer Information. Click Next. 
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9 Verify the destination folder to store Shipping Assistant files. Click Next. Note: In order to change the destination folder, click Change 

and navigate the new destination folder. 
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10 Review all Installation settings. Click Install. 
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a. Please wait as Shipping Assistant installs onto your computer. 
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b. View Install Shield Wizard Completion page. Click Finish. Note: In order to auto-launch Shipping Assistant after installation process is 

complete, verify that the launch program checkbox is checked. 

 

c. After downloading the application, the Shipping Assistant splash bar followed by the Shipping Assistant registration page will appear for first time 

users. Note: Registration is NOT required when upgrading to a new version of Shipping Assistant. 
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Upgrade to Shipping Assistant 

Note: Shipping Assistant will auto-detect if a patch or file updates and/or a new version of the application is available upon launching the old 

application. IMPORTANT: Upgrading Shipping Assistant will maintain your entire address book, shipping cart, and review my shipments 

data.  

 

 

 

 

 

 

 

 

 

 

1 Open the Shipping Assistant Application. 

2 If patch or file updates and/or a new version of the application are available, a pop-up box indicating that an update to the application is 

available. Click Continue.  

 

TIP 

- The Shipping Assistant application will not prompt you to upgrade to a new version while the application is running. To check for updates while the 

application is running, view new messages in the Message Center. If a new version is available, Exit out of Shipping Assistant and re launch the application 

while ONLINE. 

 

 

 

 

MICROSOFT VISTA OS USERS ONLY 

 

You must be logged in as an System Administrator in order to complete the update process for Shipping Assistant successfully. Please note 

that ‘elevated administrator rights’ specific to the Vista operating environment, will not suffice when attempting to upgrade, install, or uninstall 

Shipping Assistant 

 

Please follow the instructions under the Troubleshooting section in order to obtain the required Shipping Assistant update. Once these steps 

are completed, all Vista users going forward will automatically be prompted for Shipping Assistant updates per the guidelines below.  



SHIPPING ASSISTANT USER GUIDE – CHAPTER 4. UPGRADE        

                    

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      33  

 

Patch or File Updates 
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Version Updates. IMPORTANT: Version Updates will prompt you to walk through the installation process again upon completing the update. 
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3 Click Ok. 

 

Patch or File Updates 
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4 Click Continue. 

 

5 The Shipping Assistant will automatically upgrade. Note: No backwards capabilities will be provided for. You will need to attain a new 

update to continue using the Shipping Assistant application. 
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Uninstall Shipping Assistant 

Note: These steps may differ based on the operating environment. Please see general help in order to locate the add/remove programs 

functionality on a specific operating environment 

 

1 Click Start on your desktop. 

2 Click Control Panel. 

3 Click Add or Remove Programs. 

4 Select Shipping Assistant 3.2. 

5 Click Change/Remove. 

6 Select Remove the Application from this Computer. 

7 Click OK.
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Chapter 5. Registration 

In this introduction to registration, you will learn how to do the following: 

ONLINE connection status: 

• Complete profile information  

• Agree to Hazmat Question and view Privacy Policy 

• Modify connection settings  

• Register with Shipping Assistant 

 

IMPORTANT: If you have a MID/DUNS number, contact ICCC at 1-800-344-7779 in order to activate your account on 

Shipping Assistant. 

 

Getting Started 

After completing the installation process, you will have the option to auto-launch Shipping Assistant. If you choose to 

automatically launch, you will be navigated to the Shipping Assistant Registration screen. Registration is only required the 

first time after installing the Shipping Assistant application.  
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Register with Shipping Assistant 

1 Fill out the required fields on the registration screen. 

 

2 Check to agree to the Hazmat Terms. 

3 Click Privacy Policy. 
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4 Read over the Privacy Policy.  

5 Click Close. 

6 Verify connection settings. The application will automatically default the connection settings to use Internet Explorer settings. To modify 

connection settings prior to registering, see Modify Connection Settings. 
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TIP 

- To modify connection settings in the future, access the Preferences > Advanced Tab once the application has launched 

 

7 Click Cancel. 

8 Click Register. Once registration is successfully completed, the Shipping Assistant splash screen will redisplay and navigate you to the 

Create Shipping Label view of the application. 

 

IMPORTANT: If you are having any problems with your addresses, please first ensure that your address is valid by ensuring that your address 

returns on Zip Code Lookup page (http://www.usps.com/zip4). If you’re address does not appear contact your local AMS offices, which can be identified by 

using the AMS Office Locator Tool. (http://www.usps.com/ncsc/lookups/ams_office_locator.html) 

 

 

 

Modify Connection Settings  

1 Click connection settings. 

2 Select the Use Proxy Server radio button to manually enter connection information. 

3 Enter a Proxy Address (ex. http://proxy.test.com). 

 

TIP 

- Shipping Assistant is not able to execute proxy scripts to determine the actual proxy server. If a proxy script is being used with Shipping Assistant, then 

you should select ‘Use IE settings’ and insert the value in Internet Explorer as this browser is capable of executing such scripts.  

 

4 Enter a Proxy Port (ex.8080). 

5 Click Save. 
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Chapter 6. Create Shipping Labels 

In this introduction to create shipping labels, you will learn how to do the following: 

ONLINE connection status: 

• Print Shipping Labels immediately  

• When printing shipping labels immediately, specify a page range to print 

• Save This Label/Form to My Shipping Cart for printing at a later time 

• Compare Service Types related to all services available for an individual package 

• Use the Calculate functionality to view exact postage, insurance (only if integrated with a meter and printing 

postage), and service fees due for an individual package 

• Print or Email an electronic Merchandise Return Label by using the Submit button 

• Edit Sender Address using information that exists in the Address Book 

• Edit Recipient Address using Get from Address Book  

• Add Recipient Addresses entered to Address Book using Save to Address Book 

• Print Postage and Capture Weight with integrated postage device 

OFFLINE connections status: 

• Save This Label/Form to My Shipping Cart for printing at a later time. IMPORTANT: For international 

addresses, verify that your domestic Sender Address has a phone number in the address book prior to 

plugging OFFLINE. 

• Edit Sender Address using information that exists in the Address Book 

•    Edit Recipient Address using Get from Address Book 

 
Getting Started 
The Create Shipping Label page allows the user to create Domestic Labels, International Labels, Customs 2976/CN22 

and Customs 2976A/CP72 Forms, Electronic Merchandise Return Labels, and Open and Distribute.   
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Create a Domestic Label 

1 Select Domestic Shipping Label from Label Type dropdown list. 

2 Edit the Sender Information by clicking Edit Sender Address. This button will display the Address Book where a new Sender Address 

can be chosen or an existing Sender Address can be modified.  

 

TIP 

-  For more details on how to Edit Sender Information, see Address Book and Create Labels section. 

 

-  For more details on how to pre-populate the domestic label, see edit Preferences. 

  

3 Enter Recipient Information. Either manually fill in the required fields in the Recipient Information or click Get From Address Book.  Get 

From Address Book will display the Address Book where the user can choose a previously saved address(es) for the Recipient 

Information.  Only domestic addresses and/or APO/FPO addresses may be selected in this section.  
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TIP 

- For more details on how to Get From Address Book, see Address Book and Create Labels section 

- Also, when you begin typing in the Full Name, matching full names in the Address book will appear in a dropdown box. Select the correct Full Name and 

click tab in order pre-populate the Recipient field with address information. 

  

4 You may save new addresses to the Address Book by clicking Save To Address Book before proceeding with entering package 

information. All domestic addresses will automatically be standardized to USPS formatting standards upon performing this action. 

 

TIP 

- For more details on how to Save To Address Book, see Address Book and Create Labels section. 

  

5 Enter Package Information. Click Capture, if available, when you wish to capture the weight of your package on your integrated weight 

scale. Also, if available, enter a Value to be insured and subsequently pay for Insurance along with postage. See Chapter 13 for more 

details. 

 

USPS RATE CHANGES EFFECTIVE January 18, 2009 

For more details visit http://www.usps.com/ 

 

Please visit the Troubleshooting section for the most frequently asked questions regarding Shipping Assistant changes due to USPS rate 

changes  
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Example: With Meter Device 

 

 

TIPS:    

How to measure dimensions 

- For further direction on how to measure Length, Width, Height, and Girth for Large / Priority Mail items, click on Instructions hyperlink on the create 

domestic label screen or view appendix 

Compare Service Types 

-  Enter a Ship From ZIP Code if you intend on mailing your package from a ZIP Code that differs from your Sender ZIP Code to ensure correct postage 

rate attained for your mail piece. 

- Select the Service you wish to use to ship your package.  If you want to see a list of all available Services based on the Origination and Destination ZIP 

Codes, Weight, and Size entered, click Compare Service Types prior to selecting a service.  This will provide the cost, estimated delivery time, and a brief 

description of the available Services should you wish to shop across USPS services. 

1  Click Compare Service Types. 
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2 Highlight the desired Service. 

3 Click Apply Selected Service. 

 

Note: For a mapping of how the service names in the Compare Service Types pop-up related to the services in the Create Shipping Label service 

dropdown, refer to Compare Domestic Rates and Service Commitments section. 

 

 

6 Enter Package Options. Depending on the service chosen, various package additional options will be available.  Choose those you wish 

to include on your Domestic Shipping label as an endorsement. Note: For more information regarding the confirmation services available, 

refer to the Glossary section. 
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7 Click Calculate in order to display the postage, insurance fees (only if integrated with a meter and printing postage), service fees, and 

estimated delivery associated with the label you have created. Provided that enough information is provided, domestic addresses will 

automatically be standardized to USPS standards upon performing this action. If there is missing information, you will be prompted to 

correct error(s) and re-calculate to obtain rates. 
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TIP 

- If Express Mail service was selected, click Express Mail Service Commitments to view drop off location, drop off times, and service commitments. Note: 

Express Mail Service Commitments are based on Ship From ZIP Code if entered; otherwise based on Sender ZIP Code. 

 

8 Click APO/FPO restrictions to view mailing conditions regarding recipient military addresses (if applicable). 

9 Click the APO/FPO checkbox to agree to APO/FPO restrictions (required if applicable). 

10 Click the Insurance checkbox to agree to Insurance conditions (available only if printing postage & required if applicable). 

11 Check Print Postage, if enabled, when you wish to print a meter strip in addition to printing your shipping label upon clicking Print. See 

Chapter 13 for more details. 

12 Entering a number into the Number of Copies text box will create that many labels with individual barcode properties.  The maximum 

number of labels that can be printed or saved in this manner is 2000. 

13 Click Print if you wish to immediately process and print the Domestic Shipping label or click Save This Label In My Shipping Cart if you 

wish to save the label for processing and printing at a later time. If online, all domestic addresses will automatically be checked for proper 

Postal Service™ format and standardized if necessary. Upon performing either of these actions, the rate will be obtained for your most 

current label information and stored in the Review My Shipment section of the application.  Note: The delivery address manually entered 

on the label may be different than the address that appears on the label.  Check to ensure that the standardized address displayed on 

your printed label is accurate. 

 

a. When printing immediately, you can specify a print range for those image labels you wish to physically print. For example, if you 

are printing a domestic delivery confirmation label with a separate receipt you can print only the label by entering a print range of 

‘from 1 to 1’. Note Shipping Assistant will not honor any more than 2000 copies entered in the print dialog box. 
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14 If you do not wish to print or save to cart, click clear all label field. 

 

TIP 

- See Preferences for more details on how to immediately have new preferences take affect. 
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For information regarding package size requirements and how to measure packages, refer to screenshot below: 
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Create an International Label 

1 Select International Shipping Label from Label Type dropdown list 

2 Edit the Sender Information by clicking Edit Sender address. This button will display the Address Book where a new Sender Address 

can be chosen or an existing Sender Address can be modified 

 

TIP 

-  For more details on how to Edit Sender Information, see Address Book and Create Labels section. 

 

-  For more details on how to pre-populate the international label, see edit Preferences. 

 

3 Enter Recipient Information. Either manually fill in the required fields in the Recipient Information or click Get From Address Book.  Get 

From Address Book will display the Address Book where the user can choose a previously saved address to populate the Recipient 

Information.  Only international addresses may be selected 
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TIP 

-  For more details on how to Get From Address Book, see Address Book and Create Labels section. 

- Also, when you begin typing in the Full Name, matching full names in the Address book will appear in a dropdown box. Select the correct Full Name and 

click tab in order pre-populate the Recipient field with address information. 
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4 You may save a new address to the Address Book by clicking Save To Address Book (optional). 

 

TIP 

- For more details on how to Save To Address Book, see Address Book and Create Labels section. 

 

5 Enter Package Information. Enter total weight of the package in pounds and ounces including packaging and shipping labels. Note: Your 

total unit weight should not exceed the package weight. Click Capture, if available, when you wish to capture the weight of your package 

on your integrated weight scale. See Chapter 13 for more details.  

 

USPS INTERNATIONAL PRICE CHANGE EFFECTIVE January 18, 2009 

For more details visit site www.usps.com. 

 

Please visit the Troubleshooting section for the most frequently asked questions regarding Shipping Assistant changes due to USPS Price 

Change  

Example: With Meter Device 
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TIP  

- Enter a Ship from ZIP Code if you intend on mailing your package from a ZIP Code that differs from your Sender ZIP Code. 

- Select the Service you wish to use to ship your package. If you want to see a list of all available Services based on the Weight and Country entered, click 

Compare Service Types prior to selecting a service.  This will provide the cost, delivery time, and a brief description of the available Services. Note: If no 

service displays, then it is a good indication that the services offered for creating online labels via Shipping Assistant is not available to the destination 

country entered. Another convenient way to check what services are available is by going to your Shipping Tools. If no services display in the Compare 

Service Types pop-up, it means that none of the services are available for creating an international label in Shipping Assistant to the destination country. 

1   Click Compare Service Types. 

2   Highlight the desired Service. 

3   Click Apply Selected Service. 

 

Note: For a mapping of how the service names in the Compare Service Types pop-up related to the services in the Create Shipping Label service 

dropdown, refer to Compare International Rates and Service Commitments section. 
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6 Enter the Customs Information describing your package.  Also, choose the delivery option you want if, for some reason, your package 

cannot be delivered. These options may result in extra charges. Note: For more information regarding the customs information available, 

refer to the Glossary section. 

 

 

 

 

 

 

 

 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 6. CREATE INTERNATIONAL SHIPPING LABELS        

                    

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      60  

 

7 Add the various items to your package by entering a Description, Quantity, Unit Value, Unit Weight, Country of Origin, and/or HS Tariff 

Number and click Add Item.  The item and subsequent items added will be displayed in the Item Content table. Note: The maximum 

number of items that can be added to an international label is 30 items. 

 

 

 

TIP 

- To Delete a Content Item, select the item in the items table, right-click to view context menu and select Delete Item or click the Delete button 

 

-  To Modify a Content Item double-click an item in the items table, verify that content details populates in respective fields, and modify 

information. Prior to re-adding the modified item, user must delete original item record from item contents table.  
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8 Click Calculate in order to display the postage, insurance fees, and estimated delivery days associated with the label you have created. 

Note: Estimated days represents the time period for the package to go from the origin to its destination; please note that this does not 

include time for the package to go through customs.  

 

 

9 Click the mailing conditions hyperlink.  This link will display any Restrictions, Prohibitions, Observations, Customs Form Notes, and 

Express Mail International Notes based on the country you have selected. 

10 Click on the customs information hyperlink. This link will display static customs information related to all international labels 

11 Click the mailing conditions, customs information, and Insurance conditions (applicable and required only if printing postage) 

checkbox to agree to international mailing conditions, customs information, and insurance conditions (required).  

12 Check Print Postage, if enabled, when you wish to print a meter strip in addition to printing your shipping label upon clicking Print 

13  Entering a number into the Number of Copies text box will create that many labels with individual barcode properties.  The maximum 

number of labels that can be printed or saved in this manner is 2000. 

14 Click Print if you wish to immediately print the International Shipping label or Save This Label In My Shipping Cart if you wish to save 

the label for printing at a later time.  
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TIP 

- If you receive an error message that states “Requested Service is not available” it could mean that (1) The service indicated is not available to the 

destination country or (2) The weight indicated exceeds the maximum weight allowed by the destination country. For more information on how 

to view what services are available to different destination countries and details regarding maximum weight and dimension, refer to the 

Shipping Tools section.  

 

a. When printing immediately, you can specify a print range for those image labels you wish to physically print. For example, if you 

are printing an Express Mail International label you can print only the label pages by entering a print range of ‘from 1 to 5’. Note: 

Shipping Assistant will not honor any more than 2000 copies entered in the print dialog box. 

 

 

 

b. If you do not wish to print or save to cart, click clear all label fields. 

 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 6. CREATE CUSTOMS 2976/CN22 SHIPPING LABELS        

                    

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      63  

TIP 

- See preferences for more details on how to immediately have new preferences take affect. 

  

Create a Customs Form 2976/CN22 

1 Select Customs Form 2976/CN22 from Label Type dropdown list. 

2 Edit the Sender Information by clicking Edit Sender address. This button will display the Address Book where a new Sender Address can be 

chosen or an existing Sender Address can be modified. 

 

TIP 

- For more details on how to Edit Sender Information, see Address Book and Create Labels section. 

 

-  For more details on how to pre-populate the customs 2976 form, see edit Preferences. 

  

a. Enter Recipient Information. Either manually fill in the required fields in the Recipient Information or click Get From Address Book.  

Get From Address Book will display the Address Book where the user can choose a previously saved address to populate the 

Recipient Information.  International addresses or APO/FPO addresses may be selected. 
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Example: APO/FPO 

    

TIP 

- For more details on how to Get From Address Book, see Address Book and Create Labels section. 

  

4 You may save a new address to the Address Book by clicking Save To Address Book (optional). 

 

TIP 

- For more details on how to Save To Address Book, see Address Book and Create Labels section. 

  

5 Enter Package Information. Enter total weight of the package in pounds and ounces including packaging and shipping labels. Note: Your total 

unit weight should not exceed the package weight. Click Capture, if available, when you wish to capture the weight of your package on your 

integrated weight scale. See Chapter 13 for more details. 
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Example: With Meter Device 

 

 

TIP 

-  Country of Origin and HS Tariff # are optional fields and are of use to Commercial Senders only. 

 

6 Add the various items to your package by entering a Description, Quantity, Unit Value, and Unit Weight, and clicking Add Item.  The item 

and subsequent added items will be display in the Item Content Box. Note: The maximum number of items that can be added to a CN22 form 

is 3 items. 
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TIP 

- To Delete a Content Item, select the item in the items table, right-click to view context menu and select Delete Item or click Delete button 

-  To Modify a Content Item double-click an item in the items table, verify that content details populates in respective fields, and modify information. Prior to 

re-adding the modified item, user must delete original item record from item contents table.  

 

7 Click Print if you wish to immediately print the Domestic Shipping label or Save Form To My Shipping Cart if you wish to save the form 

for printing at a later time. 

   

a. When printing immediately, you can specify a print range for those image labels you wish to physically print. For example, if you are 

printing a CN22 label without instructions page you can print only the label by entering a print range of ‘from 1 to 1’. Note: This feature is 

not available when printing directly from the shipping cart. Also, Shipping Assistant will not honor any more than 2000 copies entered in 

the print dialog box. 
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9 If you do not wish to print or save to cart, click clear all label fields. 

 

TIP 

- See preferences for more details on how to immediately have new preferences take affect. 

 

Create a Customs Form 2976A/CP72 

1 Select Customs Form 2976A/CP72 from Label Type dropdown list. 

2 Edit the Sender Information by clicking Edit Sender address. This button will display the Address Book where a new Sender Address can be 

chosen or an existing Sender Address can be modified. 
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TIP 

- For more details on how to Edit Sender Information, see Address Book and Create Labels section. 

-  For more details on how to pre-populate the Customs 2976A/CP72 form, see edit Preferences. 

  

3 Enter Recipient Information. Either manually fill in the required fields in the Recipient Information or click Get From Address Book.  Get 

From Address Book will display the Address Book where the user can choose a previously saved address for the Recipient Information.  

Only international addresses or APO/FPO addresses can be chosen. 

Example: APO/FPO 

  

TIP 

- For more details on how to Get From Address Book, see Address Book and Create Labels section. 

  

4 You may save new addresses to the Address Book by clicking Save To Address Book (optional). 
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TIP 

- For more details on how to Save To Address Book, see Address Book and Create Labels section. 

  

5 Enter Package Information. Enter total weight of the package in pounds and ounces including packaging and shipping labels. Note: Your 

total unit weight should not exceed the package weight. Also, choose the delivery option you want if, for some reason, your package 

cannot be delivered; note that these may result in extra charges. Click Capture, if available, when you wish to capture the weight of your 

package on your integrated weight scale. See Chapter 13 for more details. 

Example: With Meter Device 
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TIP 

-  Country of Origin and HS Tariff # are optional fields and are of use to Commercial Senders only. 

 

6 Add the various items in your package by entering a Description, Quantity, Unit Value, and Unit Weight, and clicking Add Item.  The item 

and subsequent items added will be displayed in the Item Box. Note: The maximum number of items that can be added to a CP72 form is 30 

items. 

  

 

TIP 

- To Delete a Content Item, select the item in the items table, right-click to view context menu and select Delete Item or click Delete button 

 

-  To Modify a Content Item double-click an item in the items table, verify that content details populates in respective fields, and modify information. Prior 

to re-adding the modified item, user must delete original item record from item contents table.  
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7 Click Print if you wish to immediately print the created Domestic Shipping label or Save Form To My Shipping Cart if you wish to save the 

form for printing at a later time. 

  

a. When printing immediately, you can specify a print range for those image labels you wish to physical print. For example, if you are 

printing a cn22 label without instructions page you can print only the label by entering a print range of ‘from 1 to 1’. Note: This feature is 

not available when printing directly from the shipping cart. Also, Shipping Assistant will not honor any more than 2000 copies entered in 

the print dialog box. 

8 If you do not wish to print or save to cart, click clear all label fields. 

 

TIP 

- See preferences for more details on how to immediately have new preferences take affect. 
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Address Book Contacts and Create Label 
Edit Sender Address 

To edit information in current sender information: (IMPORTANT: When choosing a sender address, verify that a 10 digit numeric phone number 

has been entered as most of the labels will require a phone number when attempting to the print the label.) 

1 Click on the Create Shipping Label main tab. 

2 Click Edit Sender Address. The Address Book side tab will display. 

3 Click the Edit icon arrow next to the address currently in the Sender information. 

4 Make changes. 

5 Click Save.  

OR 

To change sender information to an address stored in address book: 

1  Click Edit Sender Address. The Address Book side tab will display. 

2   Select (i.e. highlight) a different Domestic address that should be inputted as the Sender Address. 

3 Click Use Selected. 

 

Get From Address Book 

1 On the Create Shipping Label screen, click Get From Address Book. 

2 Select (i.e. highlight) the address(es) that should be inputted as the Recipient Address. 

3 Click Use Selected. 

 

Save to Address Book 

1 Enter the Recipient Information into Create Shipping Label screen. 

2 Click Save to Address Book. 

TIP 

-  A unique short name will automatically be created, based on the Full Name and/or Company entered. 

- All addressed added will be added to default group “Unassigned”. 

- You cannot save addresses OFFLINE because all domestic addresses must be validated prior to being saved to the Address Book requiring 

communication with USPS. 

3 Click Save. 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 6.CREATE ELECTRONIC MERCHANDISE RETURN LABEL        

                     

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      73  

Create an Electronic Merchandise Return Label (EMR) 

1 Select Electronic Merchandise Return from Label Type. 

2 Enter your required Retailer Information.  

   

 

TIP 

- The Permit account number owner guarantees payment of the proper postage and fees on all returned merchandise return service articles distributed under the 

permit holder's permit number. Permit information can be obtained from your local Post Office. 

  

3 Enter the required Postage Due Unit Information. Note: This address will be standardized to ensure it is valid upon emailing or printing 

whether you email the label to your customer or print your label. 

  

4 Enter the required Customer Information requesting a parcel return.  This information will serve as the Return Address on the Electronic 

Merchandise Return Label.  If you wish to email the Return Label to your customer, be sure to enter the customer’s email address. 

Customer Information is required to be a valid address. Address 2 and ZIP + 4 fields have been added to ensure that all address 

information can be entered. 
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5 Enter Package Information.  

  

6 Enter any Label Options that you wish to appear on the Electronic Merchandise Return Label.  You may choose to enter an amount you 

wish to be insured, a package identification number, and a return merchandise authorization (RMA) number you indicate to expedite your 

inbound returns processing.  The system will calculate the insurance fee and display it on the label based on the value of contents you 

have specified.  You may also choose to apply Delivery Confirmation. Note: Delivery Confirmation selected for electronic Merchandise 

labels does not qualify for free or reduced electronic rates. 

 

Use RMA # in Barcode checkbox and Label Format radio buttons have been added. If the user checks Use RMA # in Barcode, the 

RMA # would then be substituted for the Sequential Package ID in the label number (PIC). This option is only available to those mailers 

who have obtained and entered their unique DUNS/Mailer ID during registration. The Label Format radio buttons allow any user the 

ability to print Electronic Merchandise Return labels so that the Customer Address appears within the window of two different types of 

#10 window envelopes. 
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7 If you wish to email the Return Label to the customer, select the Email Label To Customer radio button and click Submit. If you wish to 

print the Return Label in order to mail it with a package to the customer, select the Print Label radio button and click Submit. 

  

8 If you do not wish to email or print, click clear all label fields. 
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For detailed information and frequently asked questions surrounding the Open and Distribute service, please see Chapter 17 – 

Troubleshooting. 

 

Create an Open and Distribute Label 

 

Note: Open and Distribute Label will not be enabled unless users have a MID/DUNS number assigned to their Shipping Assistant.  Also, 

a popup will open telling users to call ICCC if they attempt to access the Open and Distribute Label page without a MID/DUNS 

number. 

1 Select Open and Distribute Label from Label Type dropdown list. 

2 Edit the Sender Information by clicking Edit Sender address. This button will display the Address Book where an existing Sender 

Address can be modified or a new Sender Address can be chosen or added. 

 

 

TIP 

- For more details on how to Edit Sender Information, see Address Book and Create Labels section. 

 

-  For more details on how to pre-populate the Open and Distribute form, see edit Preferences. 
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3 Enter Recipient Information.  
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Note: Select the destination Facility Type based on the mailing contents. If facility information is needed, click the Lookup Facility 

Address link and you will be directed to USPS Facility Access and Shipment Tracking (FAST) page. Follow the FAST instructions that 

appear when you click the ? link.  

 

 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 6. CREATE OPEN AND DISTRIBUTE LABEL       

                    

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      79  

  

4 You may save new addresses to the Address Book by clicking Save To Address Book (optional). Open and Distribute addresses 

can only be used within the Open and Distribute label. 

 

TIP 

- For more details on how to Save To Address Book, see Address Book and Create Labels section. 

 

5 Enter Package Information. Enter total weight of the drop shipment package in pounds and ounces including packaging and 

shipping labels. Enter Ship Date, Ship From ZIP Code if different from sender ZIP Code, the mail class of the Open and Distribute 

drop shipment, and the mail class enclosed. If the mail class enclosed is not listed, choose Other and enter the appropriate text in 

the Explanation field. If a scale is integrated, a Capture button would be available to capture the current weight on the 

scale. See Chapter 13 for more details regarding an integrated weight scale. 
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6 Enter Package Options. If you wish to pay for postage via a permit #, enter the number here along with the permit issuing ZIP 

Code. Check Separate Receipt to print the label and the receipt on separate pages. 

    

7 Click Calculate to obtain the price for the Open and Distribute package. Click Save This Label In My Shipping Cart for printing 

at a later time. If a meter is integrated with Shipping Assistant, the Print With Postage checkbox would be available to print an 

Open and Distribute label with postage.  Note: There is no Print option for Open and Distribute labels. 
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8 From the Shipping Cart, Open and Distribute labels may be printed.  Open and Distribute labels can only be printed with other 

Open and Distribute labels.  When Printing an Open and Distribute label, Shipping Assistant will automatically create and print a 

PS 3152 Form. 
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Chapter 7. Address Book 

In this introduction to address book, you’ll learn how to do the following: 

ONLINE connection status: 

• Add/Edit/Delete Addresses 

• Add/Delete Address Groups 

• Manage Addresses within groups 

• Show (i.e. filter) Addresses within a group/Search Addresses 

• Import Addresses into the Address Book 

• Export Addresses from Address Book 

OFFLINE connections settings: 

• Delete status 

• Add/Delete Address Groups 

• Manage Addresses within groups 

• Show (i.e. filter) Addresses within a group/Search Addresses 

• Export Addresses from Address Book 

 

Getting Started 
The Address Book allows you to add, edit, delete, bulk import/export addresses as well as manage addresses within groups.  The search 

functionality further allows you to quickly find addresses within the Address Book for use in the application.

  

Add an Address 

1 Click on the Address Book side-tab. The Address Book side panel will display. 

2 Click on the Add New Address  button to view the Address Details panel.  
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3 To add a Domestic Address, leave the default Country as United States, and fill out all required fields. 

  

4 Select one or more groups to assign the address (optional).  

 

TIP 

- If no groups are checked or available, the address will automatically be placed as an Unassigned address. 

- To create a new user defined group, refer to Add New Group section. 

 

5 Click Save to save the new domestic address to the Address Book. Note: If you decide not to save the address, make sure to 

click the Cancel button to exit the Add a New Address panel view in the Address Book. 

 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 7. ADDRESS BOOK            

  

 

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      86  

TIP 

- All domestic addresses are immediately validated against the USPS Address Management database and standardized upon saving/editing or 

importing. No invalid domestic addresses will be allowed to be saved in the Shipping Assistant Address book. 

- The system will automatically create a Short Name for the address record if you do not provide one.  The Short Name is used as a unique 

identifier and cannot be duplicated. 

 

6 To add an International Address, select a country other than the U.S., and fill out all of the required fields. 

 

7 Click Save to save the new international address to the Address Book. 
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8    Facility addresses to be used for Open and Distribute drop shipments. Users must use the Save to Address Book button directly 

from the Open and Distribute Create Shipping Label view to save facility addresses. Once saved to the address book, a user can 

edit the facility address from the Address Book. 
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Edit an Address 

1 Click on the Address Book side-tab. The Address Book side panel will display. 

2 Click on the corresponding Edit arrow button for the address record you wish to edit.  

Example: Domestic Address 

 

3 View the Address Details panel with pre-populated information. 

4 Modify the address information as desired. 

5 To change the type of address record (domestic or international), simply change the selected Country. 

6 Click Save to save the edited address to the Address Book or Cancel to discard changes. 
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TIP 

- All domestic addresses are immediately validated upon saving/editing or importing addresses. No invalid domestic addresses will be allowed to 

be saved in the Shipping Assistant Address book. 

- If the Country is grayed out, this indicates that the specific address that you are attempting to edit is currently being used as the Sender Address 

in the Create Shipping Label Tab. Since the Sender address can only be a domestic address, the country cannot be edited for this address until a 

new Sender Address is selected. 

 

Delete an Address 

1 Click the Address Book side tab. 

2 Check one or more addresses to permanently delete. 

3 Click the delete address button   to delete the addresses. 

 

4 Click OK in the confirmation window. Note: Deleting an address will permanently delete an address from the application, 

regardless of how many groups the address may be a part of. 

 

TIP 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 7. ADDRESS BOOK            

  

 

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      90  

- To simply remove an address from a specific group refer to Manage My Groups 

Add a New Group 

1 Click on the Address Book side-tab. View the Address Book main panel. 

2 Click on the Add New Group   button. View the Add New Group pop-up window. 

 

3 Enter a group name and click Save 

4 View the new group in the Show drop-down. This dropdown allows you to filter your addresses based on user-defined groups. For 

more details on how to filter the address book, refer to View Addresses in a Specific Group section. 

 

5 View the new group in the Groups selection box in the Address Details panel when adding/editing an address record. 

 

Delete a Group  

1 Click the Address Book side tab. 

2 Select a Group from the Show drop-down menu to filter address book list. 

 

 

TIP 
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- Unassigned group cannot be deleted as this is the default group that addresses are added to when no specific group has been specified. In other 

words, ‘Unassigned’ represents those addresses that are not assigned to any specific group. 

 

3 Click the delete group button to delete an existing group. IMPORTANT: Any addresses that are not assigned to another group 

will be moved to Unassigned Addresses. This action DOES NOT permanently delete any addresses. In order to permanently 

Delete an Address, see Delete an Address section. 

 

Scenario 1: If you have an address assigned to only one group, please note that by performing delete a group, the address will 

reset this address to unassigned, as it is not assigned to any user-defined groups. 

 

Scenario 2: If you have an address assigned to more than one group, please note that by performing delete a group, the address 

will remain in the group that was not deleted. 
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Manage My Groups 

The Manage Addresses section is particularly useful for managing a large number of addresses at one time.  However, users may also 

modify group assignments individually by accessing the address details panel for individual records via the Edit button. 

 

Move an Address to another Group 

This feature allows users to remove addresses from one group and/or move them to a new group. This functionality should primarily be 

used when dealing with multiple addresses 

1 Click the Address Book side tab. 

2 Select a group from the Show drop-down menu to filter the address book by a specific group. For more details on how to filter the 

address book, refer to View Addresses in a Specific Group section. 

 

3 Check one or more addresses within the group selected. View the Manage Addresses section in the lower right-hand corner of 

the Address Book panel. 

 

4 Select Move to from the Select Action drop-down menu. 

5 Select a group from the Address Group drop-down menu. IMPORTANT: Any address that is not assigned to a user-defined group 

is listed as an Unassigned Address.  Since an address cannot simultaneously exist as Unassigned and assigned to another 

group the address will be removed if ‘Unassigned’ is selected in the Address Group dropdown. 

 

IMPORTANT: If you wish to simply remove an address from a particular group, click on the Edit arrow in the Address book and 

uncheck the group in which you wish to remove the address from. See Edit an Address section for more details 
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6 Click Go. 

 

TIP 

- The selected address record now no longer exists in the group for which the table is filtered but does exist in the group selected in the Address 

Group drop-down menu. To verify, select the group name that the address was moved to in the Show dropdown box in the Address Book. 
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Add an Address to another Group 

This feature allows users to assign an address to multiple user-defined groups in the address book. Please note:  Address records 

cannot exist in a user-defined group AND in “Unassigned” addresses.  “Unassigned” is the default for address records not assigned to 

any other group. 

1 Click the Address Book side tab. 

2 Select a group from the Show drop-down menu to ensure that the addresses within a specific group are displayed. Note: A user-

defined group does not include All Addresses or Unassigned. 

 

3 Check one or more addresses from the group selected to add to an additional group by selecting the corresponding checkbox. 

View the Manage Addresses section in the lower right-hand corner of the Address Book panel. 

 

4 Select Add to from Select Action drop-down menu. 

5 Select a group from the Address Group drop-down menu. 

 

 

TIP 

- Any address that is not assigned to a user-defined group is considered unassigned.  If an address is Move To > Unassigned, the address will 

be removed from all groups that it was previously assigned to. 

 

6 Click Go. 

 

TIP 

- The selected address record now exists in the user defined group for which the table is filtered AND in the group selected in the Address Group 

drop-down menu. 
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View Addresses in a Specific Group  

Show (i.e. filter) Addresses within a Group 

1 Click the Address Book side tab. 

2 Select a group from the Show drop-down menu in order to view addresses in a specific group selected. 

 

 

Search Address Book     
Search Addresses 

1 Click the Address Book side tab. 

2 Verify that the show dropdown displays a view of addresses in a specific group of the records you wish to conduct your search 

on. 

 

3 Verify that ALL is selected under the Search For dropdown to ensure that ALL addresses within the selected group in the Show 

dropdown are displayed. 

 

4 Enter a keyword in the Search For textbox. 

5 Select a column name in the Field Name drop-down to specify a specific column to search. 

 

6 Click Go. Only addresses that match the search criteria will display in the Address Book table. 

 

IMPORTANT: In order to clear the filter to view All Addresses, please conduct the following steps 
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1 Clear out Search For text 

2 Select All Columns in Search dropdown 

3 Select All Addresses in the Show dropdown 

4 Select All link below the Search For box 

5 Click Go next to the All Columns dropdown 

 

Filter by Letter 

1 Click the Address Book side tab. 

2 Click a letter link to view all addresses with a Full Name that begins with that letter. 

 

TIP 

- If a letter is disabled it means that there are no addresses in the address book where the Full Name begins with that letter,
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Import File Specifications 

The .csv file must contain all of the following headers in the order listed below, (*) designate required fields. For a sample .csv file, please visit 
Shipping Assistant Installation page (http://www.usps.com/shippingassistant/instructions.htm). Note: If a domestic addresses cannot be validated 
based on the required fields entered, the address record will not successfully import into Shipping Assistant: IMPORTANT: See checklist 
instructions to ensure that your import file is setup correctly prior to importing into Shipping Assistant. 

• Full Name * (and/or Company) 
• Company 
• Address1* 
• Address2 
• Address3 
• City* 
• State* ( required for Domestic addresses only) 
• ZIP Code (can include ZIP + 4). Note: For international addresses this can be used to insert Postal Code. Please be aware to 

make sure that prior to saving the .csv file that no leading 0s are being removed by the application in which you are viewing your 
data. To confirm that the file is being saved properly prior to importing into Shipping Assistant, view the values in text-only format. 

• Province 
• Country* (required to state ‘United States’ for all Domestic addresses) 

• Urbanization 
• Phone Number. Note: For domestic address a valid 10 digit phone number must be provided in order to successfully import the 

phone number for a particular record. If less than 10 digits are provided for a domestic address, the phone number value  will not 
import for the record 

• Fax Number 
• Email. Note: For domestic address a valid email address must be provided in order to successfully import the email for a 

particular record. If an invalid email is provided for a domestic address, the email value will not import for the record 
• Reference Number 
• Short Name 
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IMPORTANT: If any of your addresses contain a blank Short Name, make sure to conduct the following action on the last column (i.e. Short 
Name) prior to saving .csv file in order to ensure that the .csv is created correctly prior to importing into Shipping Assistant: 
 

1 Select the entire Short Name column by clicking in the Header row for that column. 

2 Click on Edit > Go To > Blanks. 

3 Click Ok. 

4 In the formula cell, type in =””. 

5 Click Ctrl-enter. 

6 Click Save. Confirm that the following message displays. Be sure to click Yes to confirm that the file is saved in .csv format. 

 

7 Click Yes to save in .csv format. 
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Checklist for .csv files prior to Importing  

 If using Microsoft Excel® to create your .CSV, please make sure to go through the checklist below to ensure that the .csv file is correctly 

formatted before importing into Shipping Assistant.  

 

√ Verify that your file is in .CSV format and has a .CSV file extension. 

 

√ Verify that your file has no hidden columns 

 

√ Verify that your file does contain the specified import file headers and that they are in the correct order. For specific headers, see 

Import File Specifications for more instructions. 

 

√ Verify that your file contains the specified import file headers correctly spelled. See Import File Specifications for more instructions 

 

√ Verify that none of your data contains extra commas. Note: Including commas in your data will cause your file to fail the import 

process as data between two commas interpreted by Shipping Assistant as a distinct column. 

 

√ Verify that there is no extra data in any other columns, not related to a specific header. IMPORTANT: Any data that is not below a 

specified header in the .csv file may possible cause your entire file import to fail. 

 

√ If your file does not have a Short Name for every 16
th

 entry, please verify that you have completed the Import File Specifications 

instructions to ensure that your .CSV file was created correctly and to ensure a successful import. 

 

√ Verify that when viewing your .csv file in a text pad program that NO extra commas appear at the end of each row 

 

√ Verify that your .CSV file is not open upon attempting to import your addresses.  
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Import Addresses 

Before you import an address book, you’ll need to create a .csv file or export a .csv file from another application. A .csv file is a comma-

separated value file used to import and export addresses in a standard format.  Please read the Import Specifications section for details. 

Address files must be appropriately formatted to meet required, specified format used by Shipping Assistant. The Shipping Assistant 

application has leveraged the USPS Click-N-Ship existing format, facilitating seamless import of your address book existing today should you 

be a Click-N-Ship user. Although it is important to STILL go through the checklist in the instructions above to ensure the .csv file exported 

from Click-N-Ship is in the proper format. 

 

1 Export your address book from another application as a .csv file or create your own .csv file. If exporting from another application, 

follow the instructions for exporting found in your application. 

2 Verify that you have completed the checklist on the previous instruction page to ensure your .csv file is ready to be imported.  

3 Make sure you note where the exported .csv file is saved on your computer. 

4 Click on the Address Book side-tab. The Address Book side panel will display. IMPORTANT: If you are importing domestic addresses, 

verify that connection settings via preferences are correct as the application will attempt to connect online to validate domestic 

addresses. If the connection settings are not set up correctly, all domestic addresses will fail the import process. Important: Facility Type 

addresses cannot be imported into the Address Book explicitly via the import process. A DDU address would simply be imported as a 

regular domestic address, while all other Facility Types (SCF, ADC, BMC, and ASF) would fail upon import due to “missing required 

fields.” 
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5 Click on the Import Addresses button. View the Address Book – Import window. 

 

  

6 Click the Browse button to select a .csv file already appropriately formatted per Shipping Assistant specifications to import.  Make sure 

the file name is displayed in the ‘Import Path’ text box once selected. 

7 Check one or more user-defined groups in the Groups selection box to which the imported records will be a part of (optional).  If no group 

is selected, the imported address records will automatically be listed as Unassigned in the Address Book. 

8 Click the Import button to import the records from the .csv file. 

 

TIP 

- Make sure the .csv file is not open upon trying to import into the Address Book.  The system will throw an error message if the file is in use 
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9 View the import summary window, which details how many records were successful imported (added and/or overwritten)/and which 

address failed import 

 

 

TIP 

- If an address is imported with a duplicate Short Name as an address that currently exists in the application, the system will overwrite the existing address. 

The number of overwritten addresses will be displayed in the Import Summary window. 

- All domestic addresses imported will be validated. Any invalid domestic addresses will NOT be imported into the Address Book. In order to identify which 

lines of your .csv file failed to import, see View Failed Import Address Section 

 

10 Click the Finish button to return to the Address Book. Note: It is recommended to disable the ‘Enable Verbose Application Log’ checkbox 

once all import actions are completing for better performance
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View Failed Addresses  

1 After the import process is complete, click on the Failed Records hyperlink. The Failed Records pop-up will appear. 

 

2 To view the address related to each error on the screen, click on any of the row number hyperlinks. 

 
3a To export the error log (a text file version of the errors on the screen) click on the Export Error Details button. 

  Description: The Error Details allows you to easily identify which rows in your original .csv file failed, the reasons why they 

failed, and the address information associated with each failed record 

a. Enter in a name and a directory to save the error log and click Save 
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b. View confirmation pop-up that confirms that your error log has been written to a file. Click Close. 

c. Open error log in a text pad application to view details on which records failed 

 

 

      3b   To export ONLY failed address records into a NEW .csv file, click Export Failed Addresses. 

 Description: The Export Failed Addresses allows you to easily create a new .csv file of ONLY failed addresses that you can work 

on to correct the missing information detailed on the screen and re-import easily into your Shipping Assistant address book 

a. Enter in a name and directory to save the .csv file with exported addresses and click Save. 

b. View confirmation pop-up that confirms that your .csv file has been written to your desktop. Click Close. 

c. Open .csv file, correct errors and re-import. 
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4 Click Close. 

Export Addresses 

1 Click on the Address Book side-tab. The Address Book side panel will appear.  

2 Click on the Export Addresses button. View the Address Book - Export window. 

 

3 Click the Browse button to choose a file path for the exported file and type in the new file name for your exported desired address list.  

4 Click Save File. Make sure the file path is displayed in the ‘Select a File Path’ text box. 

5 In the Select Desired Address Group drop-down menu, select All Addresses or a specific address group to export records from a specific 

group 

6 Click the Export button to export the records into a .csv file. 

 

TIP 

- If replacing an existing file, make sure the .csv file is not open upon trying to export addresses. The system will throw an error message if the file is in use 

- Exporting addresses is recommended prior to deleting addresses for archiving purposes. In order to delete addresses after archiving, refer to the Delete 

Address section for instructions. 

- Open and Distribute facility addresses will not be exported by Shipping Assistant. 
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7 Follow the chosen file path to view the .csv file containing the exported address records. All exported files can be re-imported into the application 

using the import instructions in the .csv format detailed in the Import Address section above. Note: As long as the Short Name remains the same, 

modifications to the export file will overwrite the original record upon re-importing. 
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Chapter 8. Shipping Cart 

In this introduction to shipping cart, you’ll learn how to do the following: 

ONLINE connection status: 

• Print READY labels 

• Print PENDING labels. IMPORTANT: Labels in PENDING status will not automatically change to READY status after plugging ONLINE. 

You must print the label in order to begin processing. Note: There is no way to have PENDING labels go to READY status without 

printing. 

• Edit labels (PENDING & READY labels only) 

• Update Cart Prepares labels for printing and informs users if there is an error with the label. 

• Bulk Print Postage with integrated postage device 

OFFLINE connections status: 

• Print READY labels 

• Edit labels (PENDING & READY labels only) 

• Bulk Print Postage with integrated postage device 

 
Getting Started 
The Shipping Cart provides a venue where labels and forms can be stored for printing at a later date. From the shipping cart, a user can preview 

a label, edit a label, and view errors on a label. Refer to the Detailed Description of Shipping Cart Status’ for more information. 

 

Detailed Description of Shipping Cart Status’ 
In order to view ALL labels with the respective statuses below, take advantage of the Show dropdown on the upper right hand corner of the Shipping Cart 

which allows you to filter all records based on a specific status. 

 

READY: Represents a label that is ready to be printed 

• If a label is added to the Shipping Cart while you are ONLINE, the label will be set to READY status indicating the label successfully 

generated. Actions available for labels in READY status are Print Preview and Edit. 

PENDING: Label has not been processed, print will validate label information 

• If a label is added to the Shipping Cart while the user is OFFLINE, the label will always be set to PENDING status. In order to 

successful print labels in PENDING status, ONLINE status is required. 

ERROR: Represents a label that has errors that need to be corrected prior to reprocessing and printing. 
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• Upon printing a PENDING label, the system will set the label to ERROR status if an error is encountered while processing the label. 

• Please note that it is possible for a label to go from READY to ERROR status if the date the label is printed is later than the ship date 

indicated. 

 

 

For more information related to the Shipping Cart actions available, refer to the Shipping Cart Actions instructions. 

 

 

Shipping Cart Actions  

Note: All actions are available regardless of connection status.  

 

• Edit: This action gives the users the ability to remove the label from the Shipping Cart and repopulate the original information into the 

create label page for editing. This action is only available to labels with READY and PENDING status.  

 

• Update Cart: This action gives users the ability to determine if any label is in ERROR and to update a Pending label to Ready status,  

This action is available to all labels. 

 

• Delete: This action gives users the ability to remove label(s) from the Shipping Cart.  Deleting a label(s) will permanently remove that 

label.  This action is available to all labels. 

 

Edit Label 

1. Click on the Shipping Cart side-tab. The Shipping Cart side tab will display. 

2. Select (i.e. highlight) a shipping labels in PENDING or READY status.  

3. Click the Edit button on the bottom of the Shipping Cart side tab. 

4. View the confirmation pop-up window, which details the error encountered and explains that upon editing the label, the label will be 

removed from the shipping cart and re-populated in the label view for editing.  Click OK. 
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TIP 

- The Label counter will decrease by one and the Label total will decrease by the amount that the label being ‘edited’ is valued for those labels in READY 

status. For more details regarding the information displayed on the top right hand side of the application, refer to Bulk Print Labels section. 

 

5. View the label page you wish to edit (based on the label type) with pre-populated information in the fields. 

6. Modify the information as necessary. After your edit, if you wish to save changes, click Save to Address Book. 

7. Click the Save this Label In My Shipping Cart button to add the edited label back into the Shipping Cart or click Print to print label 

immediately.
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Update Cart 

1 Click on the Shipping Cart side-tab. The Shipping Cart side tab will display. 

2  Check the labels you wish to prepare. IMPORTANT: Labels that are available for printing differ depending on connection status! 

a. If ONLINE, check label(s) in READY and/or PENDING status only. 

b. If OFFLINE, check label(s) in READY status. Note: Labels in ERROR or in PENDING status cannot be printed.  

3 Click Update Cart. View the first page of the Print Wizard – Preparing Labels. 

 

4 Click Continue. View Shipping Cart with all selected label’s statuses updated. 

 

Print Labels from Shipping Cart 

1 Click on the Shipping Cart side-tab. The Shipping Cart side tab will display. 

2  Check the label you wish to print. IMPORTANT: Labels that are available for printing differ depending on connection status! 

a. If ONLINE, check label(s) in READY and/or PENDING status only. 
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b. If OFFLINE, check label(s) in READY status. Note: Labels in ERROR or in PENDING status cannot be printed.  

3 Click Print. View the first page of the Print Wizard – Preparing Labels. 

Note: Printing an Open and Distribute label will create a PS Form 3152. 

 

 

TIP 

- If any of the labels cannot be processed because they are in ERROR a message will display asking whether or not you wish to continue processing all 

remaining labels. Once remaining labels are processed, the statuses of all the labels in the cart will be updated. Refer to View/Fix Errors on Label section 

for more details. 

 

4 Click Continue. View the second page of the Print Wizard – Indicating enhanced print preferences 
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5 Click Continue. View the second page of the Print Wizard – Indicating enhanced print preferences 

a. Print labels normally – This means that all labels selected will print back to back and include all pages (inc. separate receipt, if 

indicated, mailing instructions pages, etc.) 

b. Print all selected 4x6 labels two-per page in addition to all remaining labels – This means that all 4x6 labels (listed below) will 

print 2-per page and will NOT include any separate receipt or respective mailing conditions. In addition, any other type of labels 

selected will print as they normally would to include all pages (inc. separate receipt, if indicated, mailing instructions, etc...) 
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4x6 labels eligible for 2-up are: 

•••• Domestic Priority Mail 

•••• Domestic Priority Mail Flat Rate Envelope 

•••• Domestic Priority Mail Flat Rate Box 

•••• Domestic Priority Mail Large Flat Rate Box 

•••• Domestic Priority Mail Small Flat Rate Box 

•••• Domestic Priority Mail Open and Distribute 

•••• Domestic First Class Mail Parcel 

•••• Domestic Library Mail 

•••• Domestic Media Mail 

•••• Domestic Parcel Post 

•••• Priority Mail International Flat Rate Envelope 

•••• Priority Mail International Small Flat Rate Box 

•••• First Class Mail International 

 

For example, selecting to print two Priority Mail 4x6 labels per page would look something like this: 
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6 Specify additional print preferences.  

a. Check ‘Print Preview’ checkbox if you wish to preview your bulk selected labels exactly in the order and how they would print 

prior to printing. (optional) 

b. Check ‘Print Postage’ checkbox if you are integrated with a postage device and wish to print postage to meter strips at the same 

time your labels are printed. See Chapter 13 for more details. 

7 Check do not show checkbox if you do not wish to every print two 4x6 labels per page or print preview labels prior to printing. (optional) 

 

TIP 

- Once checking ‘do not show’ checkbox, users can always re-enable the ability to specify enhanced print preferences for each print job by 

going to Preferences link – Advanced tab.   

 

8 Check Continue. View either print preview dialog box or print dialog box.  

a. On the print preview dialog box, click the print icon on the top in order to complete print job 

b. On the print dialog box, click the OK button in order to complete print job. 
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9 View the Review My Shipments section to see the list of shipping labels that successfully printed. 

 

Print All Labels in Shipping Cart 

1 View the Print All Labels button. IMPORTANT: Labels that are available for printing differ depending on connection status! 

a.  If ONLINE, this action will attempt to process and print PENDING and READY labels. 

b. If OFFLINE, this action will print READY labels only. 

 

2 View the total number of Labels indicated at the upper right hand side of the application. IMPORTANT: The Label Counter includes ALL 

labels in the Shipping Cart, regardless of status. 

3 View the Label Total counter. IMPORTANT: The Label Total counter only includes labels with READY status.  

4 Click the Print All Labels button.  
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TIP 

- If there are PENDING labels in the Cart, Print All Labels will turn to Cancel Printing to allow printing to be immediately stopped. If there are no pending 

labels in the cart this functionality is not available. 

 

5 View the summary message in the status bar of the Shipping Assistant application that details the number of labels printed out of the 

total number of labels that were attempted to be printed. 

6 View the Review My Shipments section to see the list of shipping labels that successfully printed. 

 

Delete from Shipping Cart 

1 Click Shipping Cart side tab. View the Shipping Cart side tab. 

2 Check one or more labels for deletion. 

 

TIP 

- In order to quickly check one or more labels, see shortcuts for more instructions. 

 

3 Click Delete 
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4 View Delete Shipping Cart record confirmation module. Click OK. 

 

 

 

 

 

Import Labels 

1. Click the Label Import Wizard button on the bottom of the Shipping Cart tab. 

2. On the Label Import Wizard popup, you are able to choose to import either XML or CSV formatted files.  You can also choose to create 

a new import or use an existing import format.  Note: You can only store 25 imports at a time.  Go to the Preferences hyperlink to delete 

extra imports. 
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3. Once you have selected either a new or existing data source type, click the Next button 
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4. On the Select Import File, select a Data Source Name and a File Path using the Browse button 

a. If you selected an Existing Import, the Data Source Name and File Path will be pre-populated, but editable. 

5. Click the Next button.  Note: For XML files, clicking NEXT navigates you to the Summary page, step 10. 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 9. REVIEW MY SHIPMENTS        

         

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      121  

 

6. (CSV Only) On the Select a mapping page, you may select to create a new or select an existing mapping for the import.  If you select a 

New Mapping, you must enter a mapping name 

a. If you selected an Existing Import, the Select a mapping page will default to show the previously used mapping for the import.  

You can still choose to create a new one or select a different existing mapping. 

7. Click the Next button 
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8. (CSV Only) On the Mapping Page, you can align the CSV file column names with the Shipping Assistant fields that match.  Shipping 

Assist will automatically match columns that have identical names to their respective Shipping Label Field.  You may also enter a value 

into the Default Value, which will fill any blank cell in that column with the default value.  Fields with Asterisks (*) are required. 

a. If you selected an Existing Mapping, the columns will be aligned as the Existing Mapping had them.  The columns are still 

editable. 

9. Click the Next button. 
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10. The Import Summary page allows you to view a count of failed and successful labels, view All, Successful, and Failed labels, Fix/Modify 

labels, view the errors in failed labels, Save the Imported Labels to the Shipping Cart or Print the imported labels. 
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a. There is a count of the successful and failed label imports.  You can also change the Filter to view All Labels, Successful Labels, 

and Failed Labels. 

 

b. When a Failed label is highlighted, the system will list the errors for the label 
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c. To Modify a successful label or Fix a failed label, click the Modify or Fix button.  This will open a popup with the fields listed.  

Edit the incorrect fields.  Fields that must be corrected are marked with red text.  Note: The system will not allow you to fix or 

modify a label if a field is left incorrect. 
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d. The Summary page also gives the option to Save the labels to the Shipping Cart or Print the labels immediately.  Failed labels 

will not be printed or moved to the Shipping Cart.  Note: If Shipping Assistant is offline, the Print option will not be available. 
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Chapter 9. Review My Shipments 

In this introduction to review my shipments, you’ll learn how to do the following: 

ONLINE connection status: 

• Recreate previously printed Label or Form 

• Create EMR Label (applies to domestic labels only) 

• Reprint a PS Form 3152 

• Delete printed labels 

• Check Status of Packages 

• Filter Labels In My Shipments table based on general tracking status 

• Search My Shipments 

• Bulk Print Postage for labels via integrated postage device 

OFFLINE connections status: 

• Recreate previously printed Label or Form 

• Create EMR Label (applies to domestic labels only & must be online to email or print) 

• Delete printed labels 

• Display only Labels In My Shipments table based on general tracking status 

• Search My Shipments 

• Bulk Print Postage for labels via integrated postage device 

 
Getting Started 
The Review My Shipments page shows you all labels and forms that have been printed within the Shipping Assistant application over at most 

past 120 days. It allows you to recreate previously printed labels/forms (with a new label/receipt number), create Electronic Merchandise Return 

Labels, and track the status of shipments. In addition, you can schedule free Carrier Pickup requests for package(s) that were printed via 

Shipping Assistant. 
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Search  

1 Click on Review My Shipments. 

2 Enter search criteria in the Search for textbox. 

  

3 Select a specific column from the All Columns dropdown to search within (optional). 

4 Select a specific group, based on tracking status, which you wish to conduct your Search on in the Show dropdown. 

5 Click Go. Note: To clear the search, conduct the following steps: 

a. Clear out the search criteria 

b. Select All Columns in the Search For > In dropdown 

c. Select All Shipments in the Show dropdown 

d. Click Go. 

TIP 

- To see all entries after completing a search or show, clear the Search for box, select All Columns in the dropdown next to the search field, select All 

Shipments from Show, and click Go in order to reset the Review My Shipments to display all records 

 

Check Status of Packages  

1 Click Review My Shipments main tab. 

2 Check one or more labels for a status check. 

3 Click Check Status or right click to view context menu and click Check Status.  
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TIP 

- To check the status of ALL records, do not check any records and simply click Check Status. A pop-up window will display asking you if you would like to 

check the status of ALL records. Click OK. 

 

4 The My Shipments table will be updated with the most recent shipment data for the selected record(s). 

5 To view more details, click on the Tracking Number hyperlink. A pop-up window will display for that tracking number displaying more 

details regarding the tracking status of the package. 

  

 

Display Labels for a Specific Status 

1 Click on Review My Shipments. 

2 Select a status from the Show dropdown in order to display labels based on a specific status the My Shipments table. Note: Verify that 

Search is clear if you wish to view all labels in a particular status.  Statuses include the following below: 
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LABEL PRINTED: This represents a label that has been printed but whose package label information has not been transferred to USPS. 

Once the tracking number has been acknowledged by the USPS mailing system, you will notice that the status column for a particular 

record will change to ELECTRONIC SHIPPING INFO RECEIVED. Although the detailed status has changed, the label will still display 

when filtering the My Shipments table by LABEL PRINTED, as the package has still not been transferred to USPS. 

  

IN TRANSIT: This represents all Product Tracking System (PTS) scan event status’ that imply that a label is en route and has not yet 

reached its final destination. For more details regarding where specifically a package is within the system, refer to the view track details 

instructions. 

  

DELIVERED: This represents all PTS scan event status’ that imply that a label has been delivered to its final destination. For more 

details regarding the delivery, refer to the view track details instructions. 

  

UNDELIVERABLE: This represents all PTS scan event status’ that imply that a label was not able to reach its final destination. For more 

details regarding what caused the package to be undeliverable, refer to the view track details instructions. 

 

 

Recreate Label  

Assumption: A label has already been printed via the Create Shipping Label view or via Shipping Cart. For further instructions on how to add a 

label to the cart, refer to Create Shipping Label section. 
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1 Click on Review My Shipments. 

2 Check one label. 

3 Click on Recreate Label or Form or right click to view context menu and click Recreate Label or Form. All information that was 

detailed in the printed label is transferred into the respective label page. Note: New PIC and new rate will be attained for this label. 

 

Re-Create PS Form 3152  

IMPORTANT: PS Form 3152 is required for all Open and Distribute labels. 

1. Click on Review My Shipments. 

2. Click on an Open and Distribute label 

3. Right click the label. 

4. Click Reprint PS Form 3152.
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Create Electronic Merchandise Return (EMR) Label  

IMPORTANT: It is required to have a mailing permit to use the merchandise return postage payment method service. Contact your local Post 

Office for more information. Assumption: A domestic label has already been created and you have a Permit number with USPS. For further 

instructions on how to add a domestic label to the cart, refer to Create Shipping Label section. 

 

1 Click on Review My Shipments. 

2 Check a Domestic Label that has already been previously printed. 

3 Click on Create EMR Label or right click to view context menu and click Create EMR Label. All information that was detailed in the 

domestic label is transferred into an EMR form for printing/emailing. The original label will NOT be removed from the My Shipments table.  

 

Delete printed labels 

1 Click Review My Shipments main tab. 

2 Check one or more labels. 

3 Click Delete or right click to view context menu and click Delete package record(s). The record(s) will be permanently removed from 

the My Shipments table. 
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4 Click OK. 

 

TIP 

- A record that is part of a Carrier Pickup cannot be deleted. 

- Automatic cleanup of my shipments and carrier pickup is available via preferences. 
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Chapter 10 

 
Carrier Pickup 
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Chapter 10. Chapter 10. Chapter 10. Chapter 10. Carrier PickupCarrier PickupCarrier PickupCarrier Pickup 

In this introduction to carrier pickup, you’ll learn how to do the following: 

ONLINE connection status: 

• Schedule a New Carrier Pickup  

• Modify Pickup 

• Cancel a Carrier Pickup 

• Cancel and Reschedule a Carrier Pickup 

 
Getting Started 
The purpose of the schedule carrier pickup feature is to allow you to schedule a pickup of packages from a designated location rather than 

dropping the packages off at the Post Office™ 

 

Schedule Carrier Pickup 

1 Click Review My Shipments main tab. 

2 Check one or more labels for next day Carrier Pickup. IMPORTANT: At LEAST ONE Domestic Express Mail, Express Mail Flat Rate 

Envelope, Priority Mail, Priority Mail Flat Rate Box or Priority Mail Flat Rate Envelope is required to schedule a Carrier Pickup. To 

add your international labels, First Class parcel and Package Services labels to an open Carrier Pickup request, check the labels and 

click Add to Carrier Pickup. Note: Labels can only be add/removed from a carrier pickup upon scheduling or rescheduling. Scheduling 

or Rescheduling a Carrier Pickup does not guarantee a specified pickup. 

 

TIP 

- Customs 2976/CN22 form or Customs 2976-A/CP72 forms cannot be part of a Carrier Pickup. 
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3 Click Create New Carrier Pickup. Note: For additional information on free next day Carrier Pickup view USPS.com Carrier Pickup 

(http://www.usps.com/shipping/carrierpickup/welcome.htm) link for more details per free, next day Carrier Pickup service. 

 

TIP 

- To add labels to a Carrier Pickup, check the label from the My Shipments table and click Add to Carrier Pickup. Note: Labels can only be added 

to/removed from a carrier pickup upon scheduling or rescheduling. Scheduling or Rescheduling a Carrier Pickup can only be scheduled for the next regular 

mail delivery day. 

 

- To remove labels from a Carrier Pickup, select the label from the Packages in Carrier Pickup table and click Remove from Carrier Pickup. 

 

- Tracking Details is not available while in carrier pickup mode. 

 

4 Enter the Carrier Pickup Address information in the Carrier Pickup Details or click Get from Address Book. 
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5 Enter the Carrier Pickup location information in the Carrier Pickup Details. The pickup location of the packages is associated with your 

next day Carrier Pickup request. You may want to give further description to your carrier in the Special Instructions section text box if 

Other is selected. 

6 Click Schedule Carrier Pickup. Once scheduled, all packages will appear in the My Shipments table with a confirmation number. 

IMPORTANT: Please note that the pickup date cannot be specified upon scheduling and cannot be modified without 

rescheduling the carrier pickup. Pickup dates are determined by the Next Scheduled Delivery Date available. Both the pickup date 

and confirmation number are displayed after successfully scheduling a carrier pickup.  

 

7 A Carrier Pickup confirmation number for packages in your pickup will be available from the Review My Shipments table. Note: To hide 

the Carrier Pickup panel, click on hide carrier pickups 
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Edit Carrier Pickup 

1 Click Review My Shipments main tab. 

2 Click Show Scheduled Pickups. 

3 Check a scheduled carrier pickup.  

4 Click Show Carrier Pickup Details or right-click and click Show Carrier Pickup Details. 

 

5 Edit the CARRIER PICKUP LOCATION and/or SPECIAL INSTRUCTIONS information. Only the pickup location and special instructions 

can be changed. If you wish to add/remove packages or modify pickup address, refer to Cancel and Reschedule Carrier Pickup 

instructions. 

6 Click Modify Pickup.  IMPORTANT: A carrier pickup can only be modified/cancelled prior to 2AM CST of the day of pickup.  
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Cancel Carrier Pickup 

1 Click Review My Shipments main tab. 

2 Click Show Scheduled Pickups. 

3 Check the Carrier Pickup that is to be canceled. 

4 Click Cancel Carrier Pickup or right click and select Cancel Carrier Pickup. 

5 Click Cancel from the popup box. 

 

6 The canceled Carrier Pickup will be removed from the Scheduled Carrier Pickups table. IMPORTANT: A carrier pickup can only be 

cancelled or location pickup can be modified prior to 2AM CST of the day of pickup.  

 

TIP 

- To cancel multiple carrier pickups, select the carrier pickup records and click the Cancel Carrier Pickup(s) button at the bottom of the carrier pickup 

screen.
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Cancel and Reschedule Carrier Pickup 

1 Click Review My Shipments main tab. 

2 Click Show Scheduled Pickups. 

3 Check the Carrier Pickup that is to be rescheduled. 

4 Click Cancel Carrier Pickup. 

5 Click the Cancel and Reschedule from the popup box. IMPORTANT: Clicking Cancel and Reschedule does in fact first Cancel the 

Carrier Pickup and setups a new Carrier Pickup package to be re-scheduled. Please note that upon –rescheduling a Carrier Pickup, a 

NEW confirmation will be created. 

 

6 Add/Remove Packages as desired (optional). 

7 Modify the Pickup Address and/or Pickup Location (optional). Note: Pickup address and location will default to what is indicated in 

preferences and note what was previously populated. 

8 Click Schedule Carrier Pickup. 

9 The rescheduled Carrier Pickup date will appear in the Carrier Pickups table. IMPORTANT: Pickup date cannot be specified upon 

modifying a carrier pickup. The pickup date is determined based on the Next Scheduled Delivery Date available and will be displayed 

after successfully scheduling the carrier pickup. 
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Chapter 11. Shipping ToolsChapter 11. Shipping ToolsChapter 11. Shipping ToolsChapter 11. Shipping Tools 

In this introduction to shipping tools, you’ll learn how to do the following: 

ONLINE connection status: 

• View Domestic Rates/Service Commitments, and APO/FPO restrictions   

• Capture Weight and Print Postage for a returned domestic rate 

• View International Rates/Service Commitments, international mailing conditions, maximum weight/dimensions allowed to a 

specific country, etc… 

• Capture Weight and Print Postage for a returned international rate 

• Track/Confirm packages printed both inside and outside Shipping Assistant 

• Conduct a Address lookup, ZIP Code lookup, and/or City/State lookup 

 
 

Getting Started 
With the Address Lookup feature you can verify an address, look up a ZIP Code for any given city/state, or look up a city/state using any given 

ZIP Code. You can check the delivery status of a mailing by entering a label or receipt number using the track packages feature.  The Service 

Rates Calculator allows the user to compare service options, delivery times, and rates for Domestic or International packages. All information 

entered in Shipping Tools will only be maintained within a single session. 

 

Compare Domestic Rates & Service Commitments 

1 Click Use Shipping Tools main tab. Verify that Destination is United States (Domestic Mail) 

2 Enter all required fields. Click Capture, if available, to populate the weight from  the integrated postage device 

 

TIP 

- Enter optional confirmation service and/or value of contents to obtain fees associated with confirmation service and insurance respectively 

 

3 Click Calculate Rates.  
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Example: With Meter Device 

 

 

The following information is returned as you scroll over: 

 

SERVICE: This column displays the service names that are associated with the domestic rates. 

 

ESTIMATED DELIVERY TIMES: This column details the estimated delivery times for services based on the Ship Date, Weight, and 

origin and destination ZIP Codes. In order to view Express Mail Service Commitments, click on the Overnight to most areas link. 
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TOTAL DUE: This column details the total due (i.e. LABEL TOTAL) including all postage, fees, and insurance associated with a particular 

service. 

 

POSTAGE: This column details the postage associated with a particular service. 

 

INSURANCE: This column details the insurance fee associated with a particular service based on the Value of Contents. 

 

 CONFIRMATION SERVICE: This column details the confirmation service fees for an online label. Confirmation service is required when 

creating a domestic label via Shipping Assistant, except for Express Mail. Delivery confirmation is FREE when using Priority Mail. 

 

4 Click APO/FPO restrictions to see mailing conditions regarding military addresses (if applicable button will be enabled). On the labels, 

you MUST agree to APO/FPO restrictions prior to printing or saving this label to the cart if the Recipient address is a military address. 

5 If integrated with a postage device, highlight a service row and click Print Postage to print a meter strip to an integrated postage device. 

See Chapter 13 for more details. 

 

Compare International Rates & Service Commitments 

1 Click Use Shipping Tools main tab. 

2 Select a Destination country. 

3 At the least, enter all required fields. Click Capture, if available, to populate the weight on the integrated postage device 

 

TIP 

- In order to view the max weight for a specific country, enter ‘1 LBS’ in the weight field and click calculate rate. Then, scroll over to view max weight for 

the specific country selected. 

 

4 Click Calculate Rates. 
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Example: With Meter Device 

 

 

The following information is returned as you scroll over: 

SERVICE: This column displays the service names associated with international rates.  

 

ESTIMATED DELIVERY TIMES: This column details the estimated delivery times for services based on the Ship Date, Weight, and 

destination country.  

 

TOTAL DUE: This column details the total due (i.e. LABEL TOTAL) including all postage and insurance associated with a particular 

service and the information provided. 
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POSTAGE: This column details the postage associated with a particular service and the information provided. 

 

INSURANCE FEE: This column details the insurance fee associated with a particular service and the information provided. 

 

INSURANCE COMMENT: This column details the insurance details associated with a particular service and the information provided. 

 

MAX WEIGHT: This column details maximum package weight allowed to the specified destination country. 

 

DIMENSIONS: This column details maximum package dimensions allowed to specified destination country. 

 

ORDINARY INDEMNITY: This column details the ordinary indemnity associated with a Priority Mail International label.  Essentially, it is 

insurance that is built-into the price of the service. When the ordinary indemnity value meets or exceeds the value of your package, then 

it is not necessary to pay an extra charge to insure your package. 

 

5 Select mailing conditions to view the required customs forms, restrictions and prohibitions for each country. On the labels, you MUST 

agree to mailing conditions prior to printing or saving this label to the cart. IMPORTANT: Click Calculate to be able to access mailing 

conditions. ONLINE connectivity is required. 

6 If integrated with a postage device, highlight a service row and click Print Postage to print a meter strip to an integrated postage device. 

See Chapter 13 for more details. 
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Track Packages 

 

Track Packages  

1 Click Use Shipping Tools main tab. 

2 Enter the Label No. or Receipt No field. Note: There should be no spaces or dashes 

3 Click Check Status.  The last USPS delivery scan event will display. For detailed information about the last scan event, and all scans 

related to your barcode(s), click on the tracking number hyperlink. 

 

TIP 

- There is no limit to the number of tracking numbers that can be added to the track/confirm table; but all tracking numbers will be removed upon exiting the 

application. Invalid tracking numbers will not be allowed to be added to the track/confirm table. 

 

4 In order to obtain the newest delivery scan event information for tracking numbers that already exist in the table, click Refresh.  
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Delete Tracking Numbers   

1 Click Use Shipping Tools main tab. 

2 Check the records to be deleted. 

3 Click Delete. 

 

Address Look Up 

 

Verify/Standardize Address 

1 Click Use Shipping Tools main tab. 

2 Enter Address Information (as much as known). 

3 Click Submit. A validated address will be returned and displayed in all CAPS. 

 

Lookup a City and State 

1 Click Use Shipping Tools main tab. 

2 Enter a ZIP Code in Address Information. 

3 Click Submit. A valid city/state will populate based on the ZIP Code entered. 

 

Lookup a ZIP Code 

1 Click Use Shipping Tools main tab. 

2 Enter Address 1. 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 11. SHIPPING TOOLS        

         

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      150  

3 Enter a City. 

4 Enter a State 

5 Click Submit. A valid ZIP Code will populate based on the Address Lookup. Note: If an Address 2 has not been is needed filled in but the 

system will throw a message indicating that additional information is required for a valid address, but will proceed to populate the correct 

ZIP Code. Address 1 must be provided to lookup a ZIP Code, as multiple ZIP codes can exist for a specific city and state combination. 
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Chapter Chapter Chapter Chapter 12. 12. 12. 12. PreferencesPreferencesPreferencesPreferences 

In this introduction to preferences, you’ll learn how to do the following: 

ONLINE & OFFLINE connection status: 

• Save your preferences 

• Create multiple profiles of preferences 

• Restore default preferences 

Getting Started 

The Preferences section allows you to set the most often re-used fields when creating Domestic Label, International Label, Customs 2976/CN22 

Form, Customs 2976-A/CP72 Form, Electronic Merchandise Return Label, or Open and Distribute Label. Your preferences will automatically 

populate the selected fields every time you launch Shipping Assistant. In addition, default view of Shipping Assistant upon launching, default 

values for when creating a Carrier Pickup, and much more can also be set in preferences. A profile of preferences can be created one at a time 

for each sender address specified in the labels at any given time. 

Save Your Preferences 

1 Click Preferences link. 

2 Click General (default).  

• The address currently selected as the default Sender address displays on the summary tab. This indicates the profile preferences 

that can currently be saved.  

 

TIP Multiple Profiles for Preferences 

- To create a new profile of preferences for a different address, first edit sender address and then return to these instructions. 
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3 Select a page from the open shipping assistant with dropdown to display upon launching the application.  

4 Enter Connection Preferences. For more details on how set connection settings, refer to Modify Connection Settings section. 

5 Select General Preferences. 

• PURGE FROM HISTORY AFTER: 60, 90, or 120 represent the number of days you wish to keep old printed labels in My Shipments. If 120 days is 

selected, labels that were printed more than 120 days ago and Carrier Pickups whose pickup dates were more than 120 days ago will automatically 

be permanently deleted upon launching the Shipping Assistant application. Once these labels/carrier pickup records are deleted, they cannot be 

retrieved.  IMPORTANT: Information deleted or purged from Review My Shipments cannot be retrieved. As of May 12, 2008, users have the option 
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of keeping their information indefinitely. If you wish to save your historical information outside of Shipping Assistant, copy the information displayed 

in the Review My Shipments table and paste into a Microsoft Excel. 

• PRINT WIZARD OPTIONS: These checkboxes allow you to indicated enhanced print preferences when printing labels from the Shipping Cart. 

These items include, ability to print select labels 2 per page (4x6), ability to print preview print job prior to sending to printer, and print postage 

• OTHER ADVANCED OPTIONS: This checkbox allows you to change the preference to use the X button to completely exit the Shipping Assistant 

application.  

6 Click Carrier Pickup. 

7 Enter Carrier Pickup Preferences. 
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8 Click Customs Form 2976 

9 Enter Default Customs Form 2976 Package Details. 

10 Select Default Customs Form 2876 Destination Options. 

11 Enter Default Customs Form 2976 Content Details. 
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12 Click Customs Form 2976A. 

13 Enter Default Customs Form 2976A Package Details. 

14 Select Default Customs Form 2976A Content Details. 

15 Select Default Customs Form 2976A Destination Options. 
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16 Click Domestic Label. 

17 Enter Default Domestic Package Details. 

18 Enter Default Domestic Package Options. 
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19 Click EMR Label. 

20 Enter Default Retailer Information. 

21 Enter Default EMR Label PDU Information. 

22 Enter Default EMR Label Package Details. 

23 Enter Default EMR Label Service Options. 
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24 Click International Label. 

25 Enter Default International Package Details. 

26 Enter Default International Content Details. 

27 Enter Default International Package Options. 
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28 Click Open and Distribute Label. 

29 Enter Default O&D Package Details. 

30 Enter Default O&D Package Options. 
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31 Click Postage Devices 

32 Click on Instructions on Setting up your External Device. Read through steps to ensure that your external device is setup correctly 

33 Check Use Connected External Devices 

34 Select a meter device and/or check use integrated scale 

  

 

35 Click Save.  

36 View message that indicates that all preferences will take affect upon creating the next shipping label.  Click OK. 
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TIP 

- In order to have preferences take affect immediately, either click Clear All Label Fields button on the shipping label form or Clear button on Carrier 

Pickup or simply exit and re-launch the application. This was done in order to prevent the user losing currently stored shipping label information.  
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Restore Default Preferences 

1 Click Preferences. 

2 Click reset all preferences. Preferences in all of the tabs for the specified Sender address indicated on the Summary tab will 

automatically be reset to their original settings that took affect upon original installation. 

3 Click Save. 

4 View message that indicates that all preferences will take affect upon creating the next shipping label.  Click OK. 

 

TIP 

- In order to have preferences take affect immediately, either click Clear All Label Fields button on the shipping labels form or Clear button on Carrier 

Pickup or simply exit and re-launch the application. This was done in order to prevent the user losing currently stored shipping label information.  
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Chapter 13. Working with a Chapter 13. Working with a Chapter 13. Working with a Chapter 13. Working with a ExternalExternalExternalExternal Device Device Device Device 

In this introduction to working with a postage device, you’ll learn how to do the following: 

ONLINE connection status: 

• Capture Weight and Print Postage via Create Shipping Label for domestic and international labels 

• Capture Weight and Print Postage via Shipping Tools for domestic and international labels 

• Print Postage via Review My Shipments for domestic and international labels 

• Print Postage for bulk labels via Shipping Cart for domestic and international labels 

OFFLINE connection status: 

• Print Postage via Review My Shipments for domestic and international labels 

• Print Postage for bulk labels via Shipping Cart for domestic and international labels 

 

Getting Started 

Shipping Assistant now supports a postage printing device! You can print postage to a meter strip and capture weight to make creating your 

labels even easier and faster. Please follow the steps below in order to customize your version of Shipping Assistant to work with the postage 

device. 

 

Install mailstation Assistant™ 

1 Double-click the Mailstation/setup.exe file with the mailstation Assistant™ logo 

2 Follow the prompts to install the software 

3 After downloading the application, the mailstation Assistant™ user interface will display. Please wait until the application is finished 

updating balance and obtaining updates.  

4 Confirm that mailstation Assistant™ was successfully able to connect to the external device by verifying that the image in the upper left 

hand corner matches the image below: 
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5 Click on the X on the upper-right hand corner OR select File > Close in order to minimize the application to the taskbar. IMPORTANT: 

Shipping Assistant will only allow users to communicate with external device if mailstation Assistant™ is running in the taskbar. 

 

 

 

 

Setting Your External Device and Shipping Assistant Preferences 

1 Prior to setting up your preferences in Shipping Assistant, conduct the following checklist to ensure that the application will be able to 

successfully detect your external device. 

• Verify that your mailstation 2™ (PCN K7M0) hardware USB connection is plugged into your PC 

• Verify that your mailstation 2™ (PCN K7M0) hardware device power is plugged into an outlet 

• Verify that mailstation Assistant™ application is only running in the taskbar. Tip: To verify that mailstation Assistant™ 

is only running in the taskbar, right click the image and ensure that open mailstation assistant is enabled 

•  

Right-click 
here 

Click Here to 
minimize 
mailstation 
Assistant™ to 
the taskbar 
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2 Launch Shipping Assistant 

3 Once you’re on the main screen, click Preferences hyperlink no the upper-right hand side of the application. 

4 Click Postage Devices tab. This area allows you to indicate whether or not you wish to connect to an external device. 

5 Check Use Connected External Device 

6 From select meter device dropdown, select mailstation 2™ (PCN K7M0) in the dropdown. Checking this box will enable you to print 

postage through various modules throughout the application. IMPORTANT: If an error message displays, walk through the checklist in 

step 1 again. 

7 Check Use Integrated Scale. Checking this box will enable you to capture weight through various modules throughout the application. 

This checkbox will only be enabled if your selected hardware device includes a weight scale platform. 

8 Click Save in preferences.  

9 Click Close on the confirmation message stating that all information will take affect on the next shipping label 

10 View new status bar on the bottom of Shipping Assistant 

 

 

From Create Shipping Label 

1 Click on Create Shipping Label. Select a type of label from the Select Label Type dropdown. 

2 Enter all required fields. For the weight field, click the Capture button once an item is placed on the scale.  

3 Click on Print with Postage checkbox. IMPORTANT: Printing Postage is NOT available for Customs or EMR labels. 

4 Click Print 

5 Once label is sent to the print queue, view Print Label Postage dialog box.  

6 View the left-hand side of the dialog box, where it states Print Status 

7 Click Show Label Details button to view Sender/Recipient information for current request. 

8 Wait until the print status states Insert Strip 
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9 View meter screen on mailstation 2™ (PCN K7M0) 

 

10 Insert strip into mailstation 2™ (PCN K7M0) 

$19.50 0lb  0.0oz 

Controlled by PC 
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11 Notice that Print Status on the Print Postage Dialog box changes to Printing. IMPORTANT: Ship date printed will match what was 

selected on the CSL page 

 

12 Once printing is completed, remove envelope from external device. 

13 Notice that the Print Status on the Print Postage Dialog box changes to Printed successfully…. Please wait. 
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14 Once Shipping Assistant has completed the transaction, notice that the Print Status on the Print Postage Dialog box changes to 

Completed. IMPORTANT: If there are multiple print postage requests, the Print Status will repeat the cycle. Users will be able to 

tell their progress by referring to the progress bar. 

 

15 Click Finish. 
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From Shipping Cart 

1 Click on the Shipping Cart side-tab. The Shipping Cart side tab will display. 

2 Either click Print All Labels OR check the labels you wish to print both the label and postage for.  

3 Click Print. View the Print Wizard – Preparing Labels page. This page attempts to process all labels and verify that all information 

entered is valid prior to printing labels/postage.  

4 Click Continue 

5 View the Print Wizard – Printing Preferences page. This page allows users to indicate specific additional features regarding their print 

job. 

6 Under Specify additional print preferences, check Print postage for all selected domestic and international labels. 

7 Click Continue. 

8 View the print dialog box, select desired printer, click OK. 

9 Once labels are successfully created and sent to the printer queue, view the Print Postage Dialog Box 

10 Follow the instructions above for create shipping label, for steps 5 through 15, to complete the print postage process for each individual 

request. Tip: Canceling out of printing postage will NOT have any affect on your printed labels. Labels will continue to move to Review 

My Shipments (i.e. History) section regardless if postage is successfully printed or not. Users may choose to re-print postage from 

Review My Shipments if desired. 
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From Review My Shipments    
1 Click Review My Shipments main tab 

2 Check one or more domestic/international labels that you wish to print postage for 

3 Click Print Postage or right click to view context menu and click Print Postage.  

4 View the Print Postage Dialog Box. IMPORTANT: Ship date printed will be the current date and will NOT match what was 

originally selected on the CSL page. 

5 Follow the instructions above for create shipping label, for steps 5 through 15, to complete the print postage process for each individual 

request.  

 

From Shipping Tools    
1 Click Use Shipping Tools main tab.  

2 For either a domestic or international rate, select country and enter all required fields. For the weight field, click the Capture button once 

an item is placed on the scale. If insurance is desired, check insurance checkbox and enter value of contents. 

3 Click Calculate Rates.  

4 Highlight on of the rows 

5 Click Print Postage button 

6 View the Print Postage Dialog Box. IMPORTANT: Ship date printed will be the current date and will NOT match what was originally 

selected on the CSL page. 

7 Follow the instructions on slides 15-16, to complete the print postage process for each individual request.  

 

Cancel/Errors during Printing 

For errors… 

In the event of an error occurring, either manual attendance to the postage device will be required or user can click on retry to repeat the 

last postage request OR, for more critical errors (i.e. Out of Funds) the user will be forced to terminate all pending print postage requests and 

attend to the meter accordingly. All postage can be re-printed via Review My Shipments. Note: Ship Date printed via Review My Shipments 

will always be set to the current date 
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      For cancelled print postage requests…. 

      Clicking cancel on the Print Postage Dialog box will terminate all pending print postage requests. If printing postage from Create 

Shipping Label or Shipping Cart, all labels will move to Review My Shipments regardless if print postage is successfully or not. All postage 

can be re-printed via Review My Shipments. 

 

Additional Features 

Zero Weight Scale directly from Shipping Assistant 

1 Click Preferences hyperlink 

2 Click on Postage Devices tab 

3 Click on Zero Weight button located in the Use Integrated Scale section 
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Auto-check print postage via Preferences 

1 Click Preferences hyperlink 

2 Click on Advanced tab 

3 Check Print postage for all selected domestic and international labels checkbox 
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4 Click on Domestic Label tab 

5 Check Print with Postage checkbox 

6 Click on International Label tab 

7 Check Print with Postage checkbox 

8 Click Save in preferences 

9 Click Close on confirmation box confirming that all preferences will take affect in the next shipping label. 

 

See FAQs for Troubleshooting/Frequently Asked questions with regards to working with your external device 
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Chapter 14. Help 

Click Help to view full instructions for Shipping Assistant.  

1 Click Help link on the upper right hand side of the application 

 

Use the following tabs to find information easier: 

 

CONTENTS: The contents tab allows you to click on keywords in order to easily reference quick instructions related to a specific area of 

the application. 

 

INDEX: Allows you to type in a keyword and conducts a search based on the content keywords defined. 

 

SEARCH: Allows you to type in a keyword and search ALL content in the Help file in order to find any information related to the keyword 

entered. Under Options > Search Highlight On will allow you to easily find the keyword that was entered within each related module. 
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Chapter 15. About    
Click About regarding Shipping Assistant 3.2 trademark information and customer support. In addition, users can easily access the privacy 

policy and terms and conditions that were initially available during registration. 

 

IMPORTANT: When contacting the Customer Support, whether via email or phone, please provide the identification number (located below the 

‘Registered To:’ title).  
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Chapter 16. Message Center    
Click Message Center side tab to view the latest news from USPS. Be sure to check when the message center tab turns yellow. News can 

include weather alerts, country restrictions or if there are new messages available on the Shipping Assistant browser. If you are ONLINE and 

cannot access the message center, be sure to update connection settings via Preferences > Advanced tab. 

 

TIP 

- Your Internet Explorer browser connection settings must be set correctly in order to access the Message Center within the Shipping Assistant application, 

even if manually settings have been indicated under the Preferences link .  
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Chapter 17. Troubleshooting 

This document provides answers to frequently asked questions about Shipping Assistant. Click on the hyperlink below to jump to the 

respective sections: 

Release 3.5 

o PS Form 3152 Creation 

o January 2009 USPS Price Change 

o Thermal Printing 

Release 3.3 

o Open and Distribute 

o 2008 USPS Price Change 

o Priority Mail Large Flat Rate Box 

Release 3.2 

o Changes to Marshall Islands and Micronesia addresses 

o Setting Up an External Device 

o Mailstation 2 FAQs 

o Printing Postage  

o Weight Scale / Capturing Weight 

o Insurance  

o Registration changes 

o EMR changes 

Release 3.1 

General FAQs 

Installing Shipping Assistant 

Upgrade Shipping Assistant 

Connecting ONLINE 

Registration 
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Create Shipping Label 

Address Book 

Shipping Cart 

Print Label 

Review My Shipments 

Shipping Tools 

Preferences 

Working with a Postage Device 

Message Center 

 

Release 3.5 

January 2009 Release 

 

PS Form 3152 Creation 

Q. Why has the ‘Create PS Form 3152’ button been removed from Review My Shipments? 

A. The ‘Create PS Form 3152 button has been removed from Review My Shipments page because a PS Form 3152 will be automatically printed when 

users select and print their Open and Distribute labels from the Shipping Cart. 

 

Q. Why is thermal printing not supported for Open and Distribute labels and PS Form 3152 creation? 

A. Due to fact that the PS Form 3152 can not be printed on thermal printers due to sizing issues, the ability to print  Open and Distribute labels using 

thermal printers has been removed 

 

Q. Is a PS Form 3152 required for Open and Distribute labels? 

A. A Services Certification (PS Form 3152) is required for Priority Mail Open and Distribute containers and must be presented along with appropriate 

Postage Statement to the Business Mail Entry acceptance unit that manages your account or the location designated by the Postmaster. 
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January 2009 USPS Price Change 

Q. Where can I find details about the January 18, 2009 United States Postal Service price change? 

A. Price change details can be found at http://www.usps.com/prices/. 

 

Q. How does the January 18, 2009 price change affect Shipping Assistant? 

A. Aside from the new prices for products available in Shipping Assistant, users can create Domestic and International Priority Mail Small Flat Rate Box 

labels.  Also, while Bound Printed Matter will still remain for a valid option for Merchandise Return labels it will be removed for Domestic and 

International label creation.    

 

Thermal Printing  

Q. What printers are supported for Shipping Assistant Thermal printing?   

A. Shipping Assistant supports the Zebra LP 2844-Z and S4M-ZPL thermal printers.   

 

Release 3.3 

May 2008 Release 

 

Open and Distribute 

Q. What is Priority Mail Open and Distribute service? 

A. This service provides an easy alternative to mailer-transported drop shipments for mailers who want to expedite their mailings of other classes of 

mail to domestic destination postal facilities.  The shipment receives Priority Mail service between the origin post office and the destination facility of the 

shipment, where the enclosed mail is processed and provided the appropriate service from the facility to the destination delivery unit.  For additional 

information, contact your local USPS Sales Specialist. 

 

Q. Is a barcode required for the container tag or label? 

A. Yes, An Open and Distribute Service barcode must be used on every container. The barcode will provide the date, ZIP Code™ and the time the 

container was delivered to the destination facility.  
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Q. What type of tag or label is required for Priority Mail Open and Distribute? 

A. Pink Tag 190 is required for Destination Delivery Units. 

    Green Tag 161 is required for other destinations (mail processing facilities).  

    Orange Label 23 is required for letter trays for both Destination Delivery Units and other destinations. 

 

Q. How can customers order the tags and labels? 

A. Tags or labels can be ordered by telephoning Expedited Package Supply Center at (800) 610-8734.  

 

Q. Can the orange Priority Mail sacks still be used for this service? 

A. No, the orange Priority Mail sacks should not be used.  Mailers should use to the number 3 clear sacks.  

 

Q. Can Priority Mail Open and Distribute shipments be dropped at any location? 

A. No, mailers can only present Priority Mail Open and Distribute shipments at a Business Mail Entry Unit or location designated by the postmaster.  

 

Q. How is postage calculated for Priority Mail Open and Distribute? 

A. Postage is paid based on the weight of the entire contents of the Priority Mail Open and Distribute container, excluding the tare weight.     

 

Q. How is postage paid for the mailing? 

A. Postage on the enclosed mail may be paid with any method permitted for the mail class, except for ordinary postage stamps requiring cancellation.  

Mail requiring cancellation may not be enclosed.  

Payment for the Priority Mail Open and Distribute shipment must be paid by PC Postage affixed to each Open and Distribute address label. The label is 

applied to an individual green Tag 161 or pink Tag 190 and orange Label 23. Payment may be made via permit imprint through a manifest mailing 

system.  
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Q, Are any forms required to mail Priority Mail Open and Distribute? 

A. Yes, a PS Form 3152 is necessary for the Priority Mail Open and Distribute portion of the shipment if paid by PC Postage.  The only time a postage 

statement is necessary is when postage payment is made by permit imprint for the Priority Mail Open and Distribute service. 

 

Q. Is the mail enclosed in the container required to meet corresponding eligibility standards? 

A. Yes, mail enclosed in the container is required to meet all corresponding eligibility and preparation standards for the class of mail for which postage 

has been paid.  

 

Q. Can extra services be added to the Priority Mail segment of the Priority Mail Open and Distribute shipment? 

A. No, there are no authorized extra services for the Priority Mail Open and Distribute mail container. 

 

Q. How does a mailer determine where the shipment will be processed? 

A. Customers should be directed to the Facility Access and Shipment Tracking system (FAST) at https://fast.usps.com/fast. For facility address 

information, click on “Reports”, “Mail Direction Search”, “Drop Entry Point View”. Select the destination facility based on the mailing contents in the 

container. 

 

Q. How does the mailer find an address in FAST? 

A. FAST Instructions to locate the address, city, state and ZIP Code.   

Facility Access and Shipment Tracking (FAST) 

Priority Mail Open and Distribute Service Instructions 

1. Go to https://fast.usps.com/fast/fastApp/reports/landing.action 

2. Select the following fields: 

 a. Reports 

 b. Mail Direction Search 

 c. Drop Entry Point View 
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 d. Click Create 

3. From the FAST report page, select the following search criteria fields: 

 a. Modified – Any 

 b. Effective Date – Any Current or Future 

 c. Content ZIP Code – 

  - Three digits for SCF, ADC, ASF, or BMC 

  - Five digits if Destination Delivery Unit (DDU) 

 d. Discount Type – ALL or select the facility type 

 e. Mail Class – Standard 

 f. Mail Shape – ALL 

 g. Palletized – Both 

4. To receive address information, click each box: 

 a. Show Address 

 b. Show Facility ZIP/CRID Ranges 

 c. Find the 3 digit ZIP Code in the left column 

 d. Select the corresponding facility 5 digit ZIP Code 

5. For additional help or issues, go to the: 

 a. User Guide – https://fast.usps.com/userguide/CustomerUserGuide 

 b. Customer Care Center at 800-522-9085 

 c. Email at postalone@email.usps.gov 

 

Q. How do mailers obtain Priority Mail mailing supplies? 

A. Free Priority Mail packaging and shipping supplies are available through the Postal Service Web site at http://shop.usps.com.  

Priority Mail Open and Distribute labels and tags are available by telephone from the Expedited Package Supply Center at (800) 610-8734.  

 

Q. How do I obtain information regarding Open and Distribute services? 
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A. For additional information, please refer to the Domestic Mail Manual (DMM) Section 705.16 and Publication 91, the Confirmation Services Technical 

Guide. 

 

Q. Can I save Open and Distribute facility addresses to the Address Book? 

A. Yes, but only via the Save to Address Book button within the Open and Distribute create label screen. You cannot add an Open and 

Distribute facility address directly from the Address Book. However, you can edit or delete an Open and Distribute facility address if it has 

already been saved from the Open and Distribute create label page. 

 
 
2008 USPS Price Change 

Q. Where can I find details about the May 12, 2008 United States Postal Service price change? 

A. Price change details can be found at http://www.usps.com/prices/. 

 

Q. How does the May 12, 2008 price change affect Shipping Assistant? 

A. Aside from the new prices for products available in Shipping Assistant, users can now specify a Container type for First Class Mail International. 

 

Priority Mail Large Flat Rate Box 

Q. Where can I find details about the new Large Flat Rate Box? 

A. Priority Mail Large Flat Rate Box details can be found at http://www.usps.com/rates/priority-mail-rates.htm. 

 

Q. How does the Priority Mail Large Flat Rate Box affect Shipping Assistant? 

A. Shipping Assistant users can now calculate rates and create labels for both domestic and international Priority Mail Large Flat Rate Boxes, including 

APO/FPO destinations.   

 

Release 3.2 

 

November 2007 Release 
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Marshall Islands and Micronesia 

 

Q. Why was I prompted to upgrade within a month of the October 23rd upgrade? 

A. The United States Postal Service revised the rate structure of mail to the Marshall Islands and Micronesia. Mail to these areas is now "treated as 

domestic" and Shipping Assistant was required to upgrade to conform to these changes. 

 

Q. What will happen to my current Marshall Islands and Micronesia addresses stored in my address book? 

A. Upon upgrade, the country of these addresses will automatically change to United States, and the State will become Marshall Islands or Micronesia. 

 

Q. Will these new domestic Marshall Islands and Micronesia addresses be standardized? 

A. These addresses will not standardize automatically. You may standardize these addresses by editing from the address book, making changes, and 

re-saving. 

 

Q. How can I create labels to the Marshall Islands and Micronesia after the change? 

A. You can create these labels from the Create Domestic Shipping Label form in Shipping Assistant.  

 

Q. Are all domestic services available? 

A. Collect on Delivery (COD), Delivery Confirmation, Signature Confirmation, and Electronic return receipt options will not be offered to Marshall Islands 

and Micronesia. Also, Express Mail service will be offered but without a guarantee.  

 

Q. Will Customs Forms be required now for Marshall Islands and Micronesia labels? 

A. Yes. The appropriate Customs Form will still be required. 

 

Q. What will happen to Marshall Island and Micronesia label records in Review My Shipments before the change? 

A. These records will still exist in Review My Shipments as International label records. However, you will not be able to recreate these labels. Domestic 

labels to or from Marshall Islands and Micronesia created after the upgrade will be saved as domestic label records in Review My Shipments. You will 

be able to recreate these labels. 

 

Q. What will happen to Marshall Island and Micronesia label records in the Shipping Cart before the change? 
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A. These items will change to a status of ERROR upon upgrade. You will not be able to edit these items, but instead will be forced to recreate the label 

manually in Domestic Create Shipping Label. 

 

October 2007 Release  

 

Setting Up an External Device 

 

Q. I keep receiving the following error message when attempting to connect to the mailstation 2™ (PCN K7M0) meter via Preferences: “The 

selected device is currently not available or may be used by another program” 

A. Verify that your mailstation Assistant™ application is launched and running only in the taskbar. 

 

 

Q. When I double-click on my mailstation Assistant™ application, I receive the following error message: “A software resource provided by 

mailstation assistant™ is in use by another application.” How do I access mailstation Assistant™? 

A. Exit Shipping Assistant. Users are only allowed to either use Shipping Assistant or mailstation Assistant™ at any given time in order to communicate 

with the external device hardware; therefore once a user is integrated with the device, they are forced to exit Shipping Assistant in order to access 

mailstation Assistant™. 
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Q. Are there any other postage devices besides the mailstation 2™ (PCN K7M0) that I can connect Shipping Assistant to? 

A. Not at this time. 

 

Q. My postage device is not showing up in the select device dropdown list, why? 

A. This means that Shipping Assistant cannot detect installation of the mailstation Assistant™ application on your computer. Uninstall / Re-install your 

mailstation Assistant™ application using your system Control Panel. 

 

Q. My postage device is showing up in the select device dropdown list, but my print postage and capture buttons through Shipping 

Assistant are still disabled, why? 

A. Your postage device must be connected via a USB connection in order to print postage. Verify that your USB is connected. If still disabled, exit/re-

launch Shipping Assistant to refresh the application. Also, please note that the Print Postage will not be available when connection status is OFFLINE 

for create shipping label and review my shipments modules, as internet connectivity is required in these areas in order to calculate rates. 

 

Mailstation 2 FAQs 

 

Q. Can the mailstation assistant software be used from multiple workstations?  

A. The software can be downloaded to as many computers as you would like, but only one computer can be hooked up to the meter at a time.  



SHIPPING ASSISTANT USER GUIDE – CHAPTER 17. TROUBLESHOOTING        

         

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      193  

 

Q. What is mailstation assistant? 

A. mailstation assistant™ is a PC-based software that allows you to perform postage refills and meter updates quickly and conveniently from your PC, 

which is normally much quicker than using an analog phone line.  

 

Q. Where can I find the most recent version of mailstation assistant software? 

A. To find the most recent version of mailstation assistant™ software, please click here.  

 

Q. Why do I need to check the website from time to time for software updates? 

A. Just like most things today, software gets outdated frequently.  The most recent version of software, which will include the latest enhancements, will 

always be available to download by clicking  

 

Q. How do I find supplies related to my meter? 

A. You can find supplies related to your meter under the SUPPLIES tab of mailstation assistant. 

 

Q. How do I determine if I have the correct system requirements for my mailstation assistant? 

A. To determine if you have the correct requirements: 1. From the desktop of your PC, right click on MY COMPUTER  

 

Q. What does the "rates pending" message mean? 

A. When there is a carrier rate change (e.g., USPS, UPS, FedEx, etc.), we will provide updated software for you to download approximately two (2) 

weeks prior to the carrier's rate change effective date.  When new rates are available, the “Rates Pending” message will appear in your update tab.  

 

Q. Can I print postage from mailstation assistant? 

A. No.  You can download postage, but not print postage.  The mailstation 2™ is the only postage meter that can be used with USPS Shipping 

assistant™, which can be used to compare services, create address labels, print postage to your meter, and much more.   
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Q. Can I print postage from my PC to my mailstation 2 digital postage meter? 

A. If you have downloaded USPS Shipping Assistant® and mailstation assistant™ to your PC, you will be able to print postage directly from the USPS 

Shipping Assistant™ application to your meter.  Your meter must be connected to your PC in order to do so.  

 

Q. What do I do if my PC is not showing me progress about a download or an update?  

A. Reboot the meter (unplugging your meter) and exit the PC application from the tray by right clicking on the mailstation icon and selecting exit. After 

the meter reboots, double click on the  

 

Q. Does my mailstation assistant need to be connected to an analog phone line or the computer at all times? 

A. To download postage and receive updates, your meter needs to be connected to an analog phone line or it also may be connected to your computer 

when you are performing a download.  

 

Q. How can I learn how to download postage using mailstation assistant or any other of the software functions? 

A. By clicking the SUPPORT tab within the application, you can access online demonstrations on how to use your meter for various functions including 

downloading postage and new USPS postage rates to your meter.  

 

Q. What are the system requirements for the mailstation assistant software? 

A. Your system must meet the following minimum requirements: 1. Windows 2000 and Windows XP operating systems with the latest service packs  

 

Q. Why should I use the mailstation assistant software with my mailstation equipment?  

A. You'll be able to download information directly from your computer to the postage meter  

 

Q. What do I need to do in mailstation assistant (K7M0) if a USPS rate change is about to occur or has occurred?  

A. Your mailstation assistant™ (K7M0) postage meter is equipped with the most recent version of USPS rates when you receive it.  From time to time, 

the USPS will change postage rates.  We will notify you when a rate change is going to occur, and all you need to do is download the new rates. 
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Q. Why do the balances displayed on mailstation assistant say $0?  

A. If you fund your meter by credit card, your balance will not show on the screen. Postage by Phone and Purchase Power are Pitney Bowes accounts 

that will have a $0 balance if they are not used by you. Pitney Bowes is unable to view the available balance on your credit card. When you purchase 

postage with the credit card you provided on file, the Postage in Meter value will increase by the amount you have purchased.  

 

Q. When using my Mail Station (K700), how do I use Priority Mail® International for Canada? 

A. The U. S. Postal Service has made a change to Priority Mail® International service for parcels sent to Canada.  The 1 pound minimum weight 

restriction for this service has been removed.  Your system is programmed to meet the original weight restriction, and as such will not allow rating below 

1 lb. The price for mail pieces up to 1 lb. is currently $16.00 (as of 06-07). You may still use your system to post mail below 1 lb. by using one of the two 

following methods:  

 

Printing Postage 

 

 

 

 

Q. Why does my meter sometimes display ‘Controlled by PC’? 

A. When clicking capture or print postage, Shipping Assistant will make a request to control the external device for a short period of time until the 

transaction is complete. At this time, users will see Controlled by PC on the meter screen, indicating that Shipping Assistant is in the process of 

communicating with the device. At this time, users do not need to manually attend to the meter unless an error occurs. 

  

Q. My meter still states ‘Controlled by PC’ even though I have completed my transaction from Shipping Assistant? 

A. This is a technical error and if occurs, should be very rare. In order to refresh the application(s) and external device, complete the following steps: 

• Step 1: Disconnect your USB plug 

0lb  0.0oz 

Controlled by PC 

$19.50 
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• Step 2: Re-plug your USB plug 

 

Q. Can I print postage without printing labels? 

A.  Yes, printing postage without printing labels can be completed via Review My Shipments or Shipping Tools modules. 

 

Q. Why doesn’t my meter warn me when my postage is over the high value set or when my postage is running low? 

A. In the middle of printing postage, all warnings are ignored when the meter is Controlled by PC. If a warning is encountered, a warning hyperlink will 

display at the end of printing postage on the print postage dialog box that can be clicked on to obtain additional information. 

 

Q. What does it mean when I receive the following error message in the middle of printing postage: “The application has encountered 

problems attempting to print postage. Please tend to the meter and correct before continuing? 

A. This means in the middle of attempting to print postage the meter returned an error; this could be for a variety of reasons. The best option is to view 

meter screen and verify that no error messages are being displayed and that the meter is NOT in any menu options. If the meter is in a normal state, 

click the retry button. Clicking retry will re-print the last postage request sent to the meter. 

 

 

Q. What if my print postage dialog box is stuck on “Connecting….” 
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A. This is most likely because the meter is requiring your attention prior to beginning transaction. Click the ‘Clear/Back’ button on the device multiple 

times until the meter screen returns to its default state.  

 

Q. Is there an easy way, without exiting Shipping Assistant, to view my current balance remaining in my meter prior to printing postage? 

A. Yes. You can view the current balance on the meter through either the meter status bar or by clicking on Preferences > Postage Devices. 

 

Q. An error occurred on the meter while I was printing postage from the Shipping Cart or Create Shipping Label. When I clicked OK, the 

entire dialog box and all my selected labels disappeared, why?  

A. In Shipping Assistant, an error while printing postage will not prevent labels from being successfully created, printed and moved to Review My 

Shipments. Postage can be re-printed via Review My Shipments once the physical label has been successfully printed.  

 

Q. Is there an easy way to distinguish which label I am currently printing postage for? 

A. Yes. Click on Show Label Details button on the Print Postage Dialog box to obtain Sender/Recipient information for current print postage request. 

 

Q. Why doesn’t the correct weight display when meter screen displays “Controlled by PC” when printing postage? 

A. The weight displayed on the meter has no affect on printing postage and is defaulted to the weight on the scale at that given time. 

 

Q. Will postage print in the same order as my labels printed?  

A. Yes. Regardless of how you choose to print your labels (Example: 4x6, separate receipt, or normally) your postage requests will be sent to your 

external device in the same order as they are sent to the printer. 

 

Q. Do I have to be ONLINE in order to print postage? 

A. No, if printing from Review My Shipments or Shipping Cart (for READY labels). Yes, if printing from Create Shipping Label or Shipping Tools. 

 

Q. I plugged my USB from my device into my computer, but Shipping Assistant is still stating NOT AVALIABLE in the status bar. 
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A. If Shipping Assistant is not automatically detecting the meter, click on preferences > postage devices > verify settings are correct > click save in 

preferences 

 

Q. How long does it take for the print postage dialog box to timeout? 

A. The print postage dialog box will automatically timeout and release the device from being “Controlled by PC” when the device falls asleep. Note: 

Sleep timeout is set directly via your device. 

 

Q. Can I select multiple items to print postage for in Shipping Tools? 

A. No. Only one record in Shipping Tools can be selected at any given time. 

 

Q. Why doesn’t the Sender and Ship From ZIP indicated when creating the label print on the meter strip? 

A. Sender ZIP label information is driven by the external device when printing postage. See your mailstation 2™ (PCN K7M0) user guide for more 

details on how to permanently set your Sender ZIP information. 

 

Q. I received the following error message: “Cannot print postage for an individual label with postage greater than $99.99.” What does this 

mean? 

A. This message is due to a limitation on the Pitney Bowes mailstation 2™ (PCN K7M0) meter, and therefore cannot be overridden by Shipping 

Assistant. Users must deselect any labels whose value is greater than $99.99 when printing postage to the mailstation 2™ (PCN K7M0) device. 
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Q. Are there any other postage devices besides the Pitney Bowes mailstation 2™ (PCN K7M0) that I can connect Shipping Assistant to? 

A. Not at this time. 

 

Q. Can I bulk print postage?  

A. Yes. Through both the Shipping Cart and Review My Shipments, postage can be printed in bulk for all selected domestic and international labels. In 

the Shipping Cart, check all those labels in which you wish to print postage, click Print and check Print Postage for domestic and international 

labels in the enhanced print preferences of the Print Wizard. For Review My Shipments, check the labels and simply click Print Postage. 

 

Q. Why is the selection to print postage on the enhanced print preferences page disabled when printing through the shipping cart?  

A. You’re external device must be connected via preferences at the time of clicking Print in order to be able to select to Print Postage throughout the 

application.  

 

Q. Why is the Print Postage button disabled in Create Shipping Label/Review My Shipments? 
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A.  Verify that Shipping Assistant is able to successfully integrate and connect to your postage device by referring to Working with a Postage Device in 

the user guide. Also, please note that the Print Postage will not be available when connection status is OFFLINE for create shipping label and review 

my shipments modules, as internet connectivity is required in these areas in order to calculate rates. 

 

Q. Can I refill postage while Shipping Assistant is running? 

A. Yes – by refilling postage directly through the device itself (see device user guide for more details). If you wish to use mailstation Assistant™ to refill 

postage, you must first exit Shipping Assistant and then double-click the mailstation Assistant™ icon from the taskbar. 

 

Q. Why isn’t the Print Status on the print postage dialog box moving from Printed to Printed Successfully? 

A. Most likely, the system is waiting for you to Remove Envelope from the external device in order to acknowledge that the transaction was completed 

successfully. 

 

Q. Why did my Print Postage request get terminated? 

A. Most likely because you are either low on funds or out of funds. Either refill postage using the device itself OR exit Shipping Assistant and launch 

mailstation Assistant™ to refill postage. 

 

Q. Why is the Ship Date not accurate when printing from Review My Shipments? 

A. If the ship date for a label in review my shipments is prior to the current date, the ship date printed will be printed as the current date. 

 

Weight Scale / Capturing Weight 

 

Q. Can I override the weight after capturing from the postage device? 

A. Yes, simply manually type in a new weight. Clicking capture in Shipping Assistant does nothing more than take a snapshot of the current weight on 

the weight scale platform at any given moment. 

 

Q. Can I easily capture item weight in the international, CN22, CP72, and O&D forms? 
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A. Yes. Gross weight can be captured in all the label forms (with the exception of Electronic Merchandise Return) as long as your weight scale is 

connected to Shipping Assistant. 

 

Q. How can I reset the weight of an object on the weight scale to zero? 

A. In order to zero the weight scale through Shipping Assistant, follow the steps below: 

 1 Click on Preferences hyperlink 

 2 Click on Postage Devices tab  

 3 Zero Scale button   

 

Q. Why is there no Weight Capture button even though the weight scale is connected? 

A. Verify that your preferences in Shipping Assistant are setup in order to communicate with the weight scale device. See Working with a Postage 

Device chapter in the user guide for more details. 

 

Q. Why is the Weight Capture button disabled even though I have set Preferences to use a connected postage device? 

A. Your weight scale device must be connected to the computer in order to capture weight. Verify that your USB is connected. If still disabled, exit and 

re-launch Shipping Assistant. 

 

Q. Can the weight registered on the scale differ from the weight captured in Shipping Assistant? 

A. Yes. The weight in Shipping Assistant is rounded and displayed in lbs/ounces format as opposed to the device which may only represent the weight 

in ounces. Conversion of a weight into lbs/ounces is required when printing labels and is automatically converted by Shipping Assistant. 

 

Q. Is the capture item weight feature available for Electronic Merchandise Return labels? 

A. No; although the weight captured for printed domestic labels will be re-populated here when click create EMR label from Review My Shipments for a 

selected domestic label. 

 

Insurance 
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Q. Why can I not print insurance onto my label? 

A. Insurance is only available for those users who are connected to an external postage device and who are printing postage at the time of creating a 

domestic or international label. The ability to include insurance onto a label without a postage device is not available. 

 

Q. What is ordinary indemnity? How is it different from insurance for Priority Mail International labels?  

A. Ordinary indemnity is the value of built-in coverage for the loss or damage to a package when mailing via Priority Mail International. If the calculated 

ordinary indemnity value does not cover your value of contents, you can opt to purchase additional coverage via insurance by checking the Value 

checkbox and indicating a value of contents. For all other services, no built-in coverage is available and you must purchase insurance in order to obtain 

loss/damage coverage of your package. 

 

Q. Why do I have to enter ‘Value’ if I don’t want to include insurance in my package? 

A. For international labels, entering a value of contents will allow the application to calculate and display the built-in coverage available when shipping 

via Priority Mail International. Value is not required. 

 

Q. Why, after clicking Calculate, is “Insurance” displayed as $0.00 when I have already entered a “Value” in Package Information?  

A. If you wish to purchase Insurance for your package, based on the value of contents entered, check the Value checkbox prior to clicking Calculate. 

Note: For international labels, you must enter value of contents regardless in order to obtain ordinary indemnity coverage for those packages being 

shipped via Priority Mail International. 

 

Q. Why, in Shipping Tools, can I only enter up to $500 in “Value” when the “Insurance” checkbox is checked, but I can enter up to $5000 

when the “Insurance” checkbox is not checked? 

A. When the Value checkbox is checked, the calculated insurance value will be added to the total due. Insurance for values greater than $500 must be 

purchased at a post office; although users can view the insurance fees associated with packages whose value of contents > $5,000 prior to purchasing 

at a local US Postal facility. 
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Q. Do I have to enter a “Value”?  

A. No. Entering a value of contents is optional; although, insurance fees will only be added to your total due if you check the Value checkbox. 

 

Registration 

 

Q. What is a DUNS/Mailer ID? How do I obtain it?  

A: A DUNS/Mailer ID is a unique identifier that can be used to obtain extract files from PTS with tracking information for all packages shipped 

associated with that particular DUNS/Mailer ID. Please contact Customer Support for further information. 

 

Q. Can I modify my DUNS/Mailer ID number in the future?  

A: A DUNS/Mailer ID can be added or modified, but this requires you to contact Customer Support. 

 

Electronic Merchandise Return Label 

 

Q: Why do I keep receiving errors concerning an “invalid customer address”? 

A: Shipping Assistant now requires a valid address in the Customer Information section of Electronic Merchandise Return Label. Be sure that 

all Customer Address fields are filled in accurately and completely. 

 

Q: Why is the Use RMA # In Barcode checkbox disabled, and how do I enable it?  

A: The Use RMA # In Barcode checkbox is only applicable to those mailers who entered a unique DUNS/Mailer ID during Registration. If you 

have registered for Shipping Assistant in the past without a DUNS/Mailer ID and want to use a DUNS/Mailer ID, you must contact Customer 

Support. 

 

Q: Will my RMA barcode still appear on the EMR label if I do not have a unique DUNS/Mailer ID? 

A: Yes. Your RMA # and RMA barcode will still appear on your EMR label, regardless of the existence of a DUNS/Mailer ID. The DUNS/Mailer 

ID allows for the RMA # to be included in the Delivery Confirmation or MRS bar code PIC, but does not affect the RMA barcode. 
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Q: What is the difference between the two Label Format radio buttons in the Label Options section of Electronic Merchandise Return 

Label? 

A: The Label Format radio buttons give the user the option of two Electronic Merchandise Return Label formats. #10 Window Envelopes (Left) 

would display the Customer Information within the left window of a standard #10 Window Envelopes.  #10 Window Envelopes (Right) would 

display the Customer Information within the right window of a standard #10 Window Envelopes. 

 

Q: What if I don’t intend on using a #10 Window Envelope? 

A: The label itself will not be affected by the Label Format you choose, so it will not matter which Label Format you select if you don’t plan on 

using a #10 envelope. 

 

Release 3.1 

 

Q. Why did the labels of all my status in my Shipping Cart after upgrading to the 3.1 Release? 

A. Due to the USPS rate changes for domestic labels and mail class changes for international labels, the status of all domestic and international labels 

in the cart have been updated as more information is needed. Specifically 

• All old international labels (Global Express Mail, Global Priority Mail, Global Priority Mail Large Flat Rate Envelope, and Global Airmail) have been 

updated to ERROR status and must be edited and re-added to the cart.  

• All old domestic Express Mail, Priority Mail, Priority Mail Flat Rate Envelope, Priority Mail Flat Rate Box, First Class Mail Parcel, and Bound Printed 

Matter, Library Mail, Media Mail, and Parcel Post labels have been updated to ERROR status and must be edited and re-added to the cart 

 

Q. Can I create a carrier pickup with either an old or new priority mail or express mail label and then include packages with old or new 

labels? 

A. Yes. A carrier pickup can be created with any mixture of old and new domestic and international labels as long as at least one label is either an old 

or new priority mail or express mail label. 
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General FAQs 

 

Q. How do I set my Screen Resolution to be a minimum of 1024 x 768? 

A. Right click on your desktop and select properties. Click on the Settings tab and drag your screen resolution to be set at 1024 x 768. 

 

Q. When I highlight multiple rows, only the first and last records actually check off. 

A. There is a difference between selecting (i.e. highlighting) and checking records throughout the Shipping Assistant application. When selecting (i.e. 

highlighting) rows, make sure to click on one of the read-only fields prior to checking the checkbox. See Shortcuts section for more information. 

 

Installing Shipping Assistant 

 

Q. I received an error, “Shipping Assistant could not detect your network connection status. Please verify that any desktop security 

software (intrusion protection, firewall, virus protection, etc…) allows Shipping Assistant to run as a trusted application.  Please 

contact your system administrator or USPS Customer Care Center (icustomercare@usps.com).” What should I do? 

A. This message indicates that there is another application on your desktop that is preventing Shipping Assistant from identifying your 

connection status. To fix this, you must identify which software is preventing this application and ensure that it is notified to run Shipping 

Assistant as a trusted application.  

 

Q. I received an error, “Another Instance of Shipping Assistant is already running!”, but I do not appear to have Shipping Assistant 

running. 

A. Shipping Assistant will run in the task bar, as opposed to exiting, when clicking ‘X’. To display the current session of Shipping Assistant 

double-click on the system tray on the task bar. Note: If you wish to exit the application entirely upon clicking ‘X’, see Preferences > 

Advanced section for more details. 

 

Q. How do I uninstall Shipping Assistant? 
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A. Shipping Assistant can be uninstalled through the Add/Remove Programs function under the Start menu or by inserting a CD-ROM. IMPORTANT: 

Uninstalling Shipping Assistant will NOT remove any of your data or registration information.  This ensures that all of your information will remain intact, 

regardless if a new version of Shipping Assistant is downloaded. Please note that the add/remove programs function location may differ for Vista users 

 

Q. I received a .NET Framework Initialization Error when attempting to launch Shipping Assistant. What should I do? 

A. Under Start > Control Programs > Add/Remove Programs run a repair on .NET Framework 2.0 and re-launch Shipping Assistant. 

 

Q. Is Windows 98 supported? 

A. No. Shipping Assistant supports 2000, 2003, XPHome, XPProfessional, and Vista. Please refer to System Requirements for further details. 

 

Q. When installing on a Vista machine, I received the following error message while running the setup.exe file, “Unable to save file: 

c:\\Windows\Downloaded Installations\ {A42486BE-D155-4ECA-AC29-089D0|Assistant 3.0.msi.  The system cannot find the path specified.” 

What should I do? 

A. Upon clicking OK in this dialog box, you will be prompted to select a different path. Select the Public > Public Downloads folder and click OK; then 

complete the installation process as normal 

 

Q. How do I remove my data and my registration information if I want to install a clean-version of Shipping Assistant under the same logon 

name? 

A. The default location for Shipping Assistant files is the following. Although, please note that during the installation process you do have the ability to 

change the destination location of these files: 

 

WARNING: Completing the following steps WILL PERMANENTLY DELETE ALL DATA FROM YOUR SHIPPING ASSISTANT. It is recommended that 

a backup file be saved.  

 

BE SURE TO COMPLETE BOTH STEPS. Please note that the hard drive (ex. C:\) may differ depending on the default hard drive setup on the 

individual computer: 

 

1 To remove the registration, remove the folders in the following mapping: 

 C:\Documents and Settings\<logon name>\Local Settings\Application Data\ShippingAssistant 

2. To remove the database, remove the Database and Images folders in the following mapping:  
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 C:\Documents and Settings\<logon>\Local Settings\Application Data\ShippingAssistant 

 C:\Documents and Settings\<logon>\Local Settings\Application Data\USPS\ShippingAssistant.exe_StrongName_1530igqym0lgi3fwh2vbxinwnit5pbs3 

Delete all folders 

 

 

Q. My question is not answered in the FAQ. What should I do? 

A. Contact icustomercare@USPS.com. 

 

 

Connecting ONLINE 

 

Q. I get an error message stating, “Unable to connect to remote server”. What does this mean and what should I do? 

A. This error message indicates that your computer is not able to connect to a network. This could either mean that Shipping Assistant could not 

connect to the USPS.com Web Services or may indicate that the preferences > Advanced settings are incorrect. Please verify these settings with your 

system administrator. 

 

Q. I am receiving a message indicating that Shipping Assistant could not connect to the Message Center Server, but I know that the proxy 

settings I manually entered in my Preferences are correct. 

A. The Message Center actually is displaying a browser within the Shipping Assistant application; therefore even if manual proxy settings are 

established in Preferences > Advanced tab you MUST have the correct proxy settings in your Internet Explorer browser to access the Message 

Center. In order to fix, exit Shipping Assistant, verify that your Internet Explorer proxy settings are correct, and re-launch. Proxy settings in Internet 

Explorer can be found under Tools > Internet Options > Connections > LAN Settings 

 

Upgrade Shipping Assistant 

 

Having trouble upgrading your version of Shipping Assistant? Read below for the most Frequently Asked Questions 

 

Q. Is there anyway to bypass the upgrade process? 
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A. No. All updates to Shipping Assistant are mandatory 

 

Q. How do I upgrade my version of Shipping Assistant if I am not an admin user? 

A. You must be a System Administrator in order to complete any updates and/or uninstall/re-install Shipping Assistant. Once your system administrator 

has upgraded to the new version of Shipping Assistant, all non admin users will be automatically updated.  

 

Q. Upon upgrading Shipping Assistant, will I lose all of my data? 

A. No. Upon upgrading to a new version of Shipping Assistant all your data will remain intact; data includes registration information, preferences, 

address book contacts, shipping cart labels, review my shipments information, and carrier pickups. 

 

Q. When attempting to upgrade, I received the following error “BITS cannot detect network adapter”? 

A. The upgrade from version 3.0.55.0 to 3.0.70 requires that a web service BITS is running and operating correctly. To verify that this web service is 

working correctly, please conduct the following steps: 

 

1 Go to Start > Control Panel > Performance/Maintenance > Administrative Tools > Services 

2 Verify that the “Background Intelligent Transfer Service (BITS) is running. If it is running, stop the service and restart in order to refresh the web 

service 

3 Launch Shipping Assistant. The upgrade should successfully complete. 

 

Q. MICROSOFT VISTA OS USERS ONLY. If I am a Vista user and have v3.0.55.0 (see About link) of Shipping Assistant, how do I 

obtain the newest version of Shipping Assistant? 

A.  For the time being please conduct the following steps below to obtain the newest version of Shipping Assistant. Going forward, all Vista 

users will be prompted of the upgrade upon launch. Note: You will NOT have to re-register with Shipping Assistant and all of your data 

in your address book, shipping cart, and review my shipments will be maintained regardless if you uninstall/re-install Shipping 

Assistant. 

  Step 1. Go to Start > USPS > Uninstall Shipping Assistant. Complete the uninstall Shipping Assistant process 

  Step 2. Go to USPS Shipping Assistant page (http://www.usps.com/shippingassistant/instructions.htm) and click the Download 

Now ‘Go’ button to install the latest version of Shipping Assistant 
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  Step 3. Walk through the installation process. You should notice that you will NOT be prompted to re-register 

  Step 4. Launch Shipping Assistant. You should notice that all your data has remained intact and that you have a new version 

(see About link) of Shipping Assistant available.    
 

Registration 

 

Q. I keep receiving ‘Invalid email’ when attempting to register, but everything looks correct. 

A. Verify that no spaces exist within your email addresses. 

 

Q. Do I have to register with Shipping Assistant? 

A. Yes. Registration is required prior to accessing Shipping Assistant. 

 

Create Shipping Label 

All Labels 

Q. Do I need Adobe Acrobat to view my labels? 

A. In Shipping Assistant, you do not need Adobe Acrobat Reader 5.0 or higher to “Print Label”. The new Shipping Assistant does not use Adobe for 

printing the EMR Label. However, if you use the “Email Label To Customer” option, a PDF attachment will be emailed to the customer and retailer, the 

customer and the retailer require Adobe Acrobat Reader 5.0 or higher to open and print the EMR Label. 

 

Q. I am attempting to highlight a service when viewing Compare Service Types, but the highlighted service changes before I am able to click 

Apply Selected Service. How do I select a specific service? 

A. You must either double-click the service you wish to select or click where there is white space on the row the service is listed on (as opposed to the 

hyperlink). Clicking on the white space will ensure the service remains highlighted while moving the mouse to click Apply Selected Service. 

 

Q. I modified an address in the Recipient section and clicked Save to Address Book, but my address in my address book was not updated, 

why? 
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A. Clicking Save to Address Book only adds new addresses to the Address Book. If the exact same address is added more than once, a new Short 

Name will be created. To modify an existing address you must go into the Address Book and click the Edit panel. See Edit Address section for more 

details. 

 

Q. I attempted to print multiple copies of my label, through the print dialog box, but only one copy printed. 

A. The application will only allow one copy of the label to be printed at a time. In addition, changing any of the format options in the print dialog box will 

not take affect as labels must be printed based on USPS Standards. 

 

Q. The Ship Date dropdown doesn’t appear to include today’s date. What should I do? 

A. The Ship Date dropdown currently repopulates every time the application is launched. If the application has been running in the task bar for more 

than four days, you must exit Shipping Assistant and re-launch in order for the ship date dropdown to repopulate with today’s date + 4. 

 

Q. Can I print ONLY 1 page of a label? 

A. For all labels, when printing immediately, you can specify a consecutive range of pages you wish to print via the print dialog box. For example, if you 

are creating a domestic label w/ separate receipt and click ‘print’, you can indicate that you wish to only print 1 out of 2 pages in order to avoid printing 

the ‘separate receipt’ page. 

 

Q. How do I see ‘check’ the address when in the process of creating a shipping label? 

A. Prior to clicking printing the label or saving a label to the cart, you can click Calculate which will automatically check your address and re-populate 

the Recipient address with the validated information. Please note that if you do not click calculate prior to printing the label or saving to the cart, your 

address will automatically be checked and display validated at the time of printing the label. 

 

Domestic Labels 

Q. Why can’t I enter Value of Contents in on the domestic label? 

A. The ability to calculate the insurance, based on the value of contents entered, is currently not available at this time via the Create Shipping Label. To 

view the amount of insurance available, based on a specific value of contents, see Shipping Tools section. 



SHIPPING ASSISTANT USER GUIDE – CHAPTER 17. TROUBLESHOOTING        

         

 

 
©Copyright 2009. The United States Postal Service. All Rights Reserved. Terms of Use.      211  

 

Q. I’d like to send an “oversized” package by Priority Mail. Why does Shipping Assistant set the Service to Parcel Post? 

A. A service may not be available for all package sizes. Shipping Assistant automatically limits service choices based on the package size you select. 

Oversized packages, for example, can only be sent by Parcel Post. 

 

Q. Since Shipping Assistant prints only single-ply labels for Express Mail, how do I obtain a receipt? 

A. Shipping Assistant replaces the usual Express Mail multi-ply label with a single-ply label and a printed Online Label Record. When delivering the 

package to the Post Office, present the printed Online Label Record to Postal personnel to receive the service guarantee and become eligible for a 

refund if the service guarantee isn’t met. 

 

Q. In what type of units do I enter Length, Width, Height, and Girth? 

A. Length, Width, Height, and Girth should be measured, rounded to the nearest integer and entered in by inches  

 

Q. How do I know if my package is non-machinable? 

A. Non-machinable is a mail pieces that cannot be sorted on mail processing equipment because of size, shape, content, or address legibility. Such 

mail must be processed manually. If shipping by First Class / Flat or Parcel Post, verify whether or not your item is non-machinable and check the box 

accordingly. 

 

Q. Why is Length, Width, Height (and Girth, when applicable) sometimes required for Large Priority Mail and other times not required? 

A. Rates affected by Length, Width, Height (and Girth, when applicable) depends on the ‘ship from’ and ‘ship to’ ZIP codes. For more 

information regarding how rates are calculated, visit USPS details regarding New Prices Effective May 14, 2007 

(http://www.usps.com/ratecase/). 

 

International Labels 

Q. How do I know what services are available to a specific destination country when creating an international shipping label? 
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A. By selecting a destination country, and entering the required package information, you can view all available services by clicking Compare Service 

Types button. All available services as well as their rates, based on the information provided, will display. This feature is also available via Shipping 

Tools. 

 

Q. What isn’t my mailing conditions being displayed? 

A.  Hit the Calculate button again to ensure that the correct mailing conditions are being displayed. 

 

International Labels/Customs Forms 

Q. How do I delete a content item that I have already added on the International and/or Customs forms?  

A.  Right-click on the content item table and select delete item or highlight the content item and click the delete item button. 

 

Q.  How do I modify an existing content item? 

A. You must double-click an existing content item in the table to re-populate all information. IMPORTANT: Prior to re-adding the modified item, you 

must first delete the existing content item in the table. To delete a content item, right click on the content item and select delete item. 

 

Q. Why can’t I enter all of my customs information when creating an international shipping label?  

A. When fields are grayed out on the create shipping label page, it indicates that the fields do not apply based on the service selected. You will notice 

that when different services are selected, all information that does not apply will be disabled.  

 

Electronic Merchandise Return 

Q. What is the USPS Merchandise Return Service? 

A. The Merchandise Return Service enables a retailer to provide a customer with a return shipping label (i.e. form customer to retailer), with postage 

due only when a package is returned. A retailer must have a USPS Postage Due Account to use the Merchandise Return Service. Contact your local 

Post Office for more information on how to retrieve a PDU account number. 

 

Q. How does Shipping Assistant support Merchandise Return Service? 
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A. In Shipping Assistant, you can print a Merchandise Return label to place inside the outgoing package, or you can submit a label to the USPS 

Electronic Merchandise Return Service for delivery to your customer via e-mail.  

 

Address Book 

General 

 

Q. How do I convert my Shipping Assistant 2.2 file to be compatible with Shipping Assistant? 

A. There is now a Address Book Converter tool that is available via the Message Center that allow users to easily select their 2.2 files and have them 

easily converted into a shipping assistant address book file within one-click. If you are having problems successfully converting your files, please read 

the ‘checklist’ instructions indicated on the Address Book Converter screen. 

 

Q. I cannot seem to access my existing address book contacts, instead I see a form in which to add or edit an address. 

A. Click cancel on the add or edit address book window that is currently displayed. This will close the address book panel and return you to your 

address contact information.  

 

Q. It appears that some of my addresses are no longer in Address Book. Where did they go? 

A. Conduct the following steps to ensure that there is no filter that is prohibiting specific addresses from displaying  

1 Clear out Search For text 

2 Select All Columns in Search dropdown 

3 Select All Addresses in the Show dropdown 

4 Select All link below the Search For box 

5 Click Go next to the All Columns dropdown 

 

Q. Why is the Country dropdown grayed out on my Sender Address in Address Book? 
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A. This represents that the current address being viewed is also the same address that is listed as the Sender Address on all of the labels. Since the 

sender address can only be a domestic address, the Country cannot be modified until a new Sender address is selected. In order to change the sender 

address, click edit sender address. See Address Book and Create Label instructions for more details.  

 

Q. How do I select multiple labels in the address book list? 

A. See shortcuts section for further details. 

 

Q. How many addresses can the Address Book hold? 

A. The Address Book’s capacity is limited only by the amount of space available on your hard drive. 

 

Q. Can I restore a deleted address? 

A. No. Deleted addresses cannot be recovered. When you delete an address, you are asked to confirm the deletion. That is your last change to decide 

whether or not you want to delete the address. It is recommended to export addresses you wish to delete in order to archive for future reference.  

 

Q. What can I use address groups for? 

A. Groups provide a way to organize addresses. If you run a small business, for example, you might have “Friends”, “Family” and “Customers” groups. 

If you run multiple businesses, you could set up an address group for each business. 

 

Q. If I remove an address from a group, does that delete those addresses from the Address Book? 

A. No. Removing addresses from a group does not delete those addresses from the Address Book. Addresses removed from a group are marked as 

Unassigned (unless previously assigned to another group). You can view them by selecting Unassigned in the Show list. 

 

Q. What is the difference between ‘Export Error Log’ and ‘Export Failed’ Addresses button in the ‘Failed Records’ pop-up in Address book? 

A. The Export Error log allows you to view the original row number (from the original .csv imported file), the address as it was imported into Shipping 

Assistant, and the reason that the particular line failed. The Export Failed Addresses allows you to simply create a new .CSV of only the failed 

addresses from your original imported .CSV file. You can use this new .CSV file to modify any errors noted in the Error Log.  
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Import CSV file 

Q. What is .CSV file? 

A. The comma-separated values (or CSV) file format has each data record on a line, with each record containing data fields separated by commas.  

 

Q. Where can I find a sample .csv file to import so that I can ensure my file properly formatted? 

A. Download a sample at the Shipping Assistant Website (http://www.usps.com/shippingassistant/instructions.htm) 

 

Q. How do I get my Address Book from Shipping Assistant 2.2 to import into the newest version of Shipping Assistant? 

A. Please contact USPS Customer Care Center (icustomercare@usps.com) for further instructions. 

 

Q. How much time can I expect Shipping Assistant to take to import a file? 

A. There is no exact time estimate that will be provided via Shipping Assistant at this time. Please note that the larger the file, the longer the import 

process will take, depending on your internet connection status and the time required to standardize these addresses. 

 

Q. None of my addresses imported, why? 

A. Verify that all of your proxies are correct in Preferences > Advanced section prior to importing. Since domestic addresses are required be 

standardized prior to importing, if your file contains domestic addresses and Shipping Assistant cannot connect correctly, the addresses will fail import. 

 

Q. How can I view which address lines failed during my import process? 

A. The ability to view a report of which address lines failed during the import process is currently not available through the user interface at this time. In 

order to identify which lines failed, conduct the failed import instructions for further instructions. 

 

Q. I attempt to import a .csv file and the entire application froze. 

A. In this case, we recommend ending the task by clicking Ctrl > Alt > Delete, selecting the task, and clicking End Task. This may have occurred 

due to a bad file or internet connection. First, refer to the Import Address Specifications section in the user guide to ensure that your .csv file is correctly 
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formatted prior to importing into Shipping Assistant. Then re-launch, and try again. If you are still having problems, contact 

icustomercare@USPS.com. 

Q. I re-imported a .csv file and expected some of the addresses to be overwritten, but instead the system created a whole new address 

record. Why? 

A. The system recognizes whether or not an imported address is the same as an existing address record if and only if the ‘short name’ detailed is the 

same. If you initial did not provide a ‘short name’ for each address record upon importing, the system will have created a short name for you; therefore it 

is recommended that you export the entire address book (which will include the associated short names) if you wish to make modifications offline and 

then e-import. 

 

Q. In the ‘Failed Records’ detailed pop-up, is the row numbers referring to my original .csv file that I imported or is it referring to the new .csv 

file that can be exported by clicking ‘Export Failed Addresses’ from the Failed Records pop-up. 

A. The row numbers referenced on the Failed Records pop-up references the row number on the original imported .csv file. The new .csv file that can 

be created of ONLY failed addresses is to allow users to easily pull out failed address lines. 

 

 

 

Shipping Cart 

Q. Why don’t my PENDING labels automatically turn to READY status once I’ve plugged back online.  

A. You must manually prepare the labels when online by check those labels you wish to prepare in the Shipping cart and clicking the Prepare button. 

Automatic processing of labels when connected ONLINE is currently not available at this time.  

 

Q. Is there anyway to make my labels go from PENDING to READY without printing? 

A. Yes, check labels you wish to process in the Shipping cart and click Prepare.  

 

Q. What is a PENDING shipping label? 
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A. Shipping Assistant must be able to communicate with a USPS Server to process and create your shipping label. When communication isn’t possible, 

you cannot print labels – you can only save them to the Shipping Cart. In the Shipping Cart, these labels with have PENDING in the Status column. You 

can print pending labels from the Shipping Cart after communication is established (Connection Status light at the bottom of the Shipping Assistant is 

green). See Detailed Description of Shipping Cart Status’ for further details. 

Q. I printed a label in the Shipping Cart and now it’s gone. Where is it? 

A. All printed shipping labels are listed in the My Shipments page (click the Review My Shipments button near the top of Shipping Assistant to see the 

list). 

 

Q. Can I restore a deleted shipping label? 

A. No. Deleted shipping labels cannot be recovered. When you delete a shipping label, you are asked to confirm the deletion. That is your last chance 

to decide whether you really want to delete the label. 

 

Q. How do I select multiple labels in the shipping cart list? 

A. See Shortcuts section for further details. 

 

Print Label and Shipping Cart 

 

Q. Can I print a specific range of pages via the Shipping Cart like I can when printing a label immediately? 

A. No. A specific page range for printing can only be specified when printing a label immediately. If desired, you can ‘edit’ any label from the cart and 

then click ‘Print’ to specify a specific page range; otherwise ALL pages will be printed for any label directly printed from the Shipping Cart. 

 

Q. When I click ‘print’ from the ‘print preview’ view in the Shipping Cart, nothing happens and my label does not move to ‘Review My 

Shipments’ 

 A. Most likely, you are OFFLINE and your default printer is a network printer (vs. a local printer). Since network printers require you to be connected 

to the network, you must be ONLINE in order to print or if you wish to print READY labels offline, change your default printer to a local printer. 
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Q. What are the different types of 4x6 labels that are eligible to be printed two-per page when indicating print preferences? 

A. 4x6 labels include  

• Domestic Priority Mail 

• Domestic Priority Mail Flat Rate Envelope 

• Domestic Priority Mail Flat Rate Box 

• Domestic First Class Mail Flat 

• Domestic First Class Mail Parcel 

• Domestic Bound Printed Matter 

• Domestic Library Mail 

• Domestic Media Mail 

• Domestic Parcel Post 

• International Priority Mail Flat Rate Envelope 

• International First Class Mail International 

 

Q. Why aren’t the receipts/mailing instructions pages for my 4x6 labels printing out? 

A. Prior to printing if you specify that you wish to print two 4x6 labels per page, Shipping Assistant will NOT print any of the corresponding receipt or 

mailing instructions page associated with the labels. 

 

Q. Is it possible, when printing two 4x6 labels on one page, for an international label and a domestic label to be printed on the same page? 

A. Yes.  

 

Review My Shipments 

 

General 

Q. Is there a way to check the status of ALL my labels in Review My Shipments? 
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A. Yes. Verify that none of your labels are checked, and click check status. You will be asked to confirm whether or not you wish to check the status 

of all of the labels in your Review My Shipments table, as it may take sufficient processing time.  

 

Q. Why aren’t any of my tracking details displaying when I click the tracking number hyperlink? 

A. In order to view tracking details under Review My Shipments section, you must exit out of the Carrier Pickup view by clicking hide carrier pickup 

and be ONLINE. 

 

Carrier Pickup 

Q. When I click Cancel and Reschedule Carrier Pickup, will my previous request be cancelled? 

A. Yes. Upon re-scheduling your carrier pickup please note that a new confirmation number will be available upon completing your request. See 

Cancel and Reschedule Carrier Pickup instructions for more details. 

 

Q. I selected (i.e. highlighted) a label in Review My Shipments and clicked Create Carrier Pickup, but none of my packages moved over to 

the Carrier Pickup view, why? 

A. You must check which items you wish to include in your Carrier Pickup package prior to clicking Create Carrier Pickup. Clicking Create Carrier 

Pickup without checking any items will simply create a blank Carrier Package form in which you can then add and remove labels. 

 

Q. I selected a label to be added to my carrier pickup and it no longer appears under my Review My Shipments view. 

A. When creating a carrier pickup, any labels that have been added to the Carrier Pickup package will temporarily not display in the Review My 

Shipments table. Once you have completed scheduling your Carrier Pickup, the labels that are a part of the Carrier Pickup package will reappear in 

your Review My Shipments table and will include a confirmation number in the last column of the table to illustrate that they are part of a Carrier 

Pickup. 

 

Q. In the Carrier Pickup view, I placed a checkbox next to the labels I wished to schedule my package with, but after scheduling it appears 

that all of my labels were scheduled. 
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A. Clicking the checkboxes only relates to the Remove from Carrier Pickup button. If you do not wish to include labels currently in your Carrier 

Pickup view, you must first check those labels and click Remove from Carrier Pickup prior to Scheduling the Carrier Pickup. 

 

Q. Why won’t Shipping Assistant let me cancel, or modify a Pickup? 

A. Carrier Pickups can only be cancelled and/or modified prior to 2AM CST of the day of the pickup. Any modifications at this time are prohibited. 

 

Q. I clicked on show scheduled pickups, but do not see a list of all my scheduled carrier pickups. 

A. Click close on the Carrier Pickup view that you are currently on. Upon completing this action, you will be returned to a list of all scheduled Carrier 

Pickups. 

Q. Why doesn’t the Schedule Carrier Pickup button do anything when I click it? 

A. A Carrier Pickup must include at least one domestic Express Mail or Priority Mail package, so review the packages you’ve selected to be sure one 

such package is present. Also, make certain all required fields are filled in. 

 

Q. Can I schedule a Carrier Pickup for next week? 

A. No. Carrier Pickups can only be scheduled for the next scheduled delivery day. 

 

Q. Can I remove a package from a scheduled Carrier Pickup? 

A. No. Once a pickup is scheduled you cannot remove a package from it without canceling the current pickup. Shipping Assistant makes canceling 

and editing labels in a package easy by making use of the Cancel and Reschedule Carrier Pickup functionality. See Cancel and Reschedule Carrier 

Pickup section for more details. 

 

 

Shipping Tools 

 

Domestic/International Rate and Service  

Q. Where can I view Express Mail Service Commitments? 
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A. Click on the Overnight to Most Areas hyperlink once you have calculated the rate for Express Mail in the table 

 

Tracking 

Q. Why can’t I add certain tracking numbers to the tracking table? 

A. If a tracking number does not have a status that is deemed valid (i.e. information has been archived), a message will immediately appear indicating 

why the tracking number is invalid. 

 

Address Verification 

Q. What does address verification do? 

A. Address verification compares the address you entered to the USPS list of known addresses. If you entered an address incorrectly (wrong ZIP 

Code or misspelled street name, for instance), verification automatically updates the address fields with the correct information.  

 

Q. What happens if an address can’t be verified? 

A. If Shipping Assistant cannot verify an address, it will display a message identifying a possible problem. Correct the problem and try verifying the 

address again. 

 

Q. Why does address verification change addresses to all uppercase letters? 

A. USPS has standardized on uppercase letters to eliminate capitalization inconsistencies during information processing and automated mail 

processing. 

 

Preferences 

 

Q. Why aren’t my preferences taking affect? 

A. In order to avoid overwriting existing information entered on the labels, you must either click clear all label fields on each of the respective labels 

and/or finish either printing or saving to cart. Exiting and re-launching Shipping Assistant will also allow preferences to take affect immediately for all 

labels. 
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Q. Can I have different preferences setup for different Sender Addresses within the same copy of Shipping Assistant? 

A. Yes. Every time you select a new Sender Address by clicking edit sender address in the Create Shipping Label section, a new profile is created 

and new preferences can be set. Please note that when a new sender address is selected, all preferences defined in the previous sender address are 

automatically duplicated. In order to reset preferences to blank for all fields, click reset preferences in Preferences. 

 

Q. If I recreate a label, will the Sender Address’s preferences that are populated in the Sender field take affect after I print the current label? 

A. No. Recreating labels from Review My Shipments only temporarily populates the Sender Address in the respective label. After printing/saving to 

cart, the current Sender addresses’ preferences will populate the create shipping label fields. 

 

Q. How can I tell which addresses I have created preferences for? 

A. This functionality is not available at the current time. You can only view the preferences that have been saved for the current Sender Address. 

 

Q. What do the preference settings do? 

A. Most of the preferences automatically populate fields when you are creating labels. By presetting fields to the values you use most often, you will 

reduce label creation time and minimize errors. 

 

Q. Do I have to fill in every preference field? 

A. No fill in just the fields that will be the same for most labels. Preference fields you don’t fill in will remain blank (or at least their default settings) 

when you create labels. 

 

Q. If I set preference fields, will I have to use those values in every label? 

A. No. When you are creating labels, you can override any pre-populated field. 

 

Q. How should I set the Connection Preferences in the Advanced tab? 

A. In most cases, select the Use Internet Explorer option. If you have a proxy server, select the Use Proxy Server option and fill in the Address and 

Port. If you aren’t certain which option to select, check with your System or Network Administration. 

 

Q. What does ‘Specify Print Preferences’ checkbox represent? 

A. If this is checked, you will have the ability to view the enhanced print preferences page during every print job from the Shipping Cart. This will allow 

you to indicate special print features such as ability to print two 4x6 labels on a single page or print preview a set of selected labels prior to printing.  
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Message Center 

 

Q. Why is the Message Center tab yellow? 

A. The Message Center is yellow when new information is available from USPS. When you open the Message Center, the tab changes back to red. 

 

Q. What kinds of information shows up in the Message Center 

A. What you see in the Message Center may change from day to day. Messages may include USPS news, Shipping Assistant announcements and 

tips, special promotions and information from USPS partners. 

 

Q. How can I save information I see in the Message Center? 

A. Click the Print button to print all of the messages. 
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Chapter 18. Appendix 

Domestic Service Descriptions 

Express Mail / Own Packaging = Next day delivery by noon or 3:00pm to many U.S. destinations. Delivery to most locations 365 days a year, including Sundays and 

holidays at no extra charge. Must be mailed by scheduled acceptance time. Official USPS packaging and stickers is required for domestic Express Mail; these can be 

purchased online at the Postal Store or at your local retail Post Office for free. 

Express Mail / Flat Rate Envelope (12.5” x 9.5”) = Next day delivery by noon or 3:00pm to many U.S. destinations. Delivery to most locations 365 days a year, 

including Sundays and holidays at no extra charge. Must be mailed by scheduled acceptance time. Official USPS packaging and stickers is required for domestic 

Express Mail; these can be purchased online at the Postal Store or at your local retail Post Office for free. 

Priority Mail / Own Packaging = For sending a package up to 70 pounds and maximum length plus girth of 108 inches. Delivery is made in an average of 2 to 3 days. 

Official USPS packaging and stickers is required for domestic Express Mail; these can be purchased online at the Postal Store or at your local retail Post Office for free. 

Priority Mail / Flat Rate Envelope (12.5’ x 9.5”) = For sending a document for one rate, regardless of weight. Delivery is made in an average of 2 to 3 days. Official 

USPS packaging and stickers is required for domestic Express Mail; these can be purchased online at the Postal Store or at your local retail Post Office for free. 

Priority Mail / Flat Rate Box (11.25” x 8.75” x 6”) = For sending a package for one rate, regardless of weight. Delivery is made an average of 2 to 3 days. Official 

USPS packaging and stickers is required for domestic Express Mail; these can be purchased online at the Postal Store or at your local retail Post Office for free. 

Priority Mail / Flat Rate Box (14” x 12” x 3.5”) = For sending a package for one rate, regardless of weight. Delivery is made an average of 2 to 3 days. Official USPS 

packaging and stickers is required for domestic Express Mail; these can be purchased online at the Postal Store or at your local retail Post Office for free. 

Priority Mail / Small Flat Rate Box (8.625” x 5.375” x 1.625”) = For sending a package for one rate, regardless of weight. Delivery is made an average of 2 to 3 days. 

Official USPS packaging and stickers is required for domestic Express Mail; these can be purchased online at the Postal Store or at your local retail Post Office for free. 

First Class Mail / Flat = First-Class Mail is used for personal and business correspondence. It includes postcards, letters, large envelopes, small packages, and any 

item weighing 13 ounces or less. 

First Class Mail / Parcel = First-Class Mail is used for personal and business correspondence. It includes postcards, letters, large envelopes, small packages, and any 

item weighing 13 ounces or less. 

Media Mail = For sending a small or large package, or a thick envelope. Contents limited to books, manuscripts, sound recordings, recorded videotapes and recorded 

computer-readable media. 

Library Mail = For sending an item to or from a school, college, university, public library, museum, or herbarium or a nonprofit religious, education, scientific, 

philanthropic (charitable), agricultural, labor, veterans, or fraternal organization or association. 

Parcel Post = For sending a small or large package, thick envelope or tube containing gifts or merchandise 
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Domestic Service Options  

Summary: The list below displays the weight limit and size options available for each of the domestic mail service container options 

 

√ Express Mail : Standard/Own Packaging weight limit is 70 lb. 0 oz. & size options are Standard and Large 

√ Express Mail : Flat Rate Envelope weight limit is 70 lb. 0 oz. & size options are Standard 

 

√ Priority Mail : Standard/Own Packaging weight limit is 70 lb. 0 oz. & size options are Standard and Large 

√ Priority Mail : Flat Rate Envelope weight limit is 70 lb. 0 oz. & size options are Standard 

√ Priority Mail : Flat Rate Box weight limit is 70 lb. 0 oz. & size options are Standard 

√ Priority Mail: Large Flat Rate Box weight limit is 70 lb. 0 oz & size options are Standard 

√ Priority Mail: Small Flat Rate Box weight limit is 70 lb. 0 oz & size options are Standard 

√ Priority Mail: Rectangular weight limit is 70 lb. 0 oz & size options are Large 

√ Priority Mail: NonRectangular weight limit is 70 lb. 0 oz & size options are Large 

 

√ First Class Mail : Parcel weight limit is 0 lb. 13 oz. & size options are Standard and Large 

 

√ Library Mail weight limit is 70 lb. 0 oz. & size options are Standard and Large 

√ Media Mail weight limit is 70 lb. 0 oz. & size options are Standard and Large 

√ Parcel Post weight limit is  70 lb. 0 oz. & size options are Standard, Large and Oversize 
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International Service Descriptions 

Express Mail International = Expedited air service to 190 countries with delivery time average of 3-5 business days and a service guarantee to 

select destinations. Tracking available and free insurance up to $100. Check destination country weight limitations. 

Priority Mail International = Accelerated air service with 6 - 10 average business day delivery.  Tracking available to major destinations with 

ordinary indemnity included at no additional cost. 

First Class Mail International = Airmail service worldwide up to 4 pounds.  Registered Mail service is available. 

 

International Service Options  

Summary: The list below displays the weight and content item limits for each of the international mail service options 

√ Express Mail International weight limit is 70 lb. 0 oz & content item limit is 30 items. Note: by choosing ‘Express Mail International’ 

the Abandon option of In Case Of No Delivery will be disabled 

 

√ Priority Mail International weight limit is 70 lb. 0 oz. & content item limit is 30 items. 

√ Priority Mail International / Flat Rate Box weight limit is 20 lb. 0 oz. & content item limit is 30 items. 

√ Priority Mail International / Flat Rate Envelope weight limit is 4 lb. 0 oz. & content item limit is 5 items. 

√ Priority Mail International / Large Flat Rate Box weight limit is 20 lb. 0 oz. & content item limit is 30 items. 

√ Priority Mail International / Small Flat Rate Box weight limit is 4 lb. 0 oz. & content item limit is 5 items. 

 

√ First Class Mail International weight limit is 4 lb. 0 oz. & content item limit is 5 items. 
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Chapter 19. Resources 

 

Order Self-Adhesive Labels 

(https://www.labeluniverse.com/store/index.cgi?function=items&cat=

US_Postal_Service_Shipping_Labels) 

 

Order Shipping Supplies (https://shop.usps.com/) 

 

Domestic Mail Manual 

(http://pe.usps.gov/text/dmm300/dmm300_landing.htm) 

 

International Mail Manual (http://pe.usps.gov/text/imm/welcome.htm) 

 

IMM Special Services (http://pe.usps.gov/text/imm/immc3_001.html) 

 

General Information 

1-800-ASK-USPS®
®
 or (800) 275-8777 

Hours of Operation:  

Monday through Friday from 8:00 a.m. to 8:30 p.m. (Eastern Time)  

Saturdays from 8:00 a.m. to 6:00 p.m. (Eastern Time)  

Closed Sundays and Holidays 

 

 

 

 

Domestic Package Tracking 

1-800-222-1811 

Hours of Operation:  

Monday through Friday from 7:30 a.m. to 10:30 p.m. (Eastern Time)  

Saturdays, Sundays and Holidays from 9:00 a.m. to 8:00 p.m. 

(Eastern Time)  

 

International Package Tracking 

1-800-222-1811 

Hours of Operation:  

Monday through Friday from 8:00 a.m. to 9:30 p.m. (Eastern Time)  

Saturdays from 9:00 a.m. to 7:00 p.m. (Eastern Time)  

Closed Sundays and Holidays 

 

TDD/TTY 

1-877-TTY-2HLP (877-889-2457)  

Hours of Operation:  

Monday through Friday from 7:30 a.m. to 10:00 p.m. (Eastern Time)  

Saturdays from 8:00 a.m. to 8:00 p.m. (Eastern Time)  

Sundays and Holidays from 9:00 a.m. to 8:00 p.m. (Eastern Time) 

 

USPS Internet Customer Care Center: icustomercare@USPS.com 
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Chapter 20Chapter 20Chapter 20Chapter 20. . . . GlossaryGlossaryGlossaryGlossary 

Add to: add an address to multiple groups 

APO/FPO information: describes mailing conditions for sending a mail piece to a military address 

Carrier Pickup Location: identifies where the package will be left for pickup 

Check Status: updates the tracking status of selected labels 

Contents: general description of the package contents 

Country of Origin: the country from which the item(s) being mailed originated from 

Create Carrier Pickup: creates a new carrier pickup  

Create EMR Label: creates Electronic Merchandise Return Label for a domestic label that has already been printed 

Customer Reference #: a number identifier chosen by the user for the recipient 

Default Sender Address: Indicates the address currently displayed in the Sender Address for all of the labels. This address is the same 

address that displays on the Summary tab of the Preferences link, indicating that saved preferences are tied to this Sender Address.  

Delivery Confirmation Service:  provides date, ZIP Code and time your package was delivered 

Edit Sender Address: changes/modifies sender address for the selected shipping label 

Error: label has errors that need to be corrected 

Export Addresses: copies selected addresses into a .csv file and saves them in a user defined location 

Get From Address Book: inserts a recipient address into the selected shipping label from the Address Book 

HS Tariff Number:  A 6-10 digit number used to classify products for customs purposes as a means amongst international business community to 

standardize import/export classifications.  When users ship products internationally, they are required to assign products this 6 - 10 digit long code 
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that complies with the HS (Harmonized System) standard.  All businesses required to determine/assign code.  Selling a single item, however, such 

as from an auction site, internationally may not require a HS number, only a customs form. 

Import Addresses: imports a .csv file of addresses into the address book 

In: searches in a chosen field of a table for the criteria entered in ‘Search for’  

Ordinary indemnity: a value that is associated with a Priority Mail International label that is essentially insurance that is built-into the price of 

the service. When the Ordinary indemnity value that is covered by Priority Mail International label is greater than the value of contents, 

then you do not have to pay any extra charge for coverage of your shipping package 

Mailing Permit: Permission to mail at bulk (presorted) rates 

Move to: move an address from one group to another 

No Holiday Delivery: will not deliver the Express Mail package on a Holiday 

Non-Machinable: mail pieces that cannot be sorted on mail processing equipment because of size, shape, content, or address legibility. Such mail must 

be processed manually 

No Weekend Delivery: will not deliver the Express Mail package on a Weekend 

Oversized Rate: Parcel Post rate for pieces exceeding 108 inches but not more than 130 inches in combined length and girth 

Package ID: An ID created/specified by the retailer to associate a label to a product, or customer.  It really is wholly retailer defined.  It is an identifier of 

the package coming back that a retailer may or may not choose to use 

Permit Number: The Permit account number owner guarantees payment of the proper postage and fees on all returned merchandise return service 

articles distributed under the permit holder's permit number. Permit information can be obtained from your local Post Office. 

Pending: label is in queue 

PS Form 3152: A Confirmation Service certificate that is required for Priority Open and Distribute containers. 
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Product Tracking Service (PTS): The system that provides the delivery status of Priority Mail, Express Mail, and Package Services (Parcel Post, 

Bound Printed Matter, Library Mail, and Media Mail) packages with Delivery Confirmation. 

Quantity: number of items being shipped 

Ready: label is ready to be printed 

Recreate Label or Form: recreates a label or form that has already been printed 

Request Service Address: directs the Postal Office on how to handle a mail piece that cannot be delivered 

Return Label: prints the recipient a preprinted label to use if they send the mailed item back to the sender 

Save to Address Book: saves the recipient address information to the Address Book 

Search for: searches a table for the criteria entered in the text box 

Send Email to Recipient: generates and sends an email to the recipient informing them of shipment details 

Separate Receipt: prints a separate receipt showing details about the shipping label 

Service: lists the mail service types available to ship a package 

Ship Date: the date the package will be delivered to the postal service 

Ship from ZIP Code: identifies the ZIP Code from which the package is being shipped if different from the sender address 

Show: shows only the group or status selected in the table 

Signature Confirmation Service: provides date, ZIP Code, time your package was delivered and requires a signature from the person who 

accepts the package 

Unit Value $: represents the value of a single item. For example, a box of 50 pens is worth $1.00; therefore the unit value is $1.00. 

Unit Weight: represents the weight of a single item. For example, a box of 50 pens weights 1 lb 0 ounces; therefore the unit weight is 1 lb 0 

ounces.  
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Value of Contents: identifies the value of the contents being shipped 

Waive Signature: authorizes delivery of an Express Mail piece without obtaining a recipient signature 


